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Chapter 1  

Budgeting and 
Financial Reporting 
Concepts in Excel 
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1. Consolidating Budgets – CPAs often have a need to consolidate data such as: 
 

 Months 

 Departments 

 Locations 

 Warehouses 

 Sale Representatives 

 
In this section we will explore four consolidation methods - two methods for consolidating 
data that is similar, and two more methods for consolidating data that is dissimilar. These 
four methods are as follows: 

 
1. Using simple formulas to consolidate similar data. 
2. Using spearing formulas to consolidate similar data. 
3. Using the “Data Consolidate Command” to consolidate dissimilar similar data. 
4. Using the “PivotTable Wizard” to consolidate dissimilar similar data. 

 
1. Using Simple Formulas To Consolidate Similar Data - The workbook below contains 

identical budgets for Departments A, B, C and D. The goal is to consolidate these four 
budgets into one consolidated budget. 

  

 
 

 CTRL + Drag Tab – Select worksheet labeled “Dept D”. Use the CTRL + Drag Tab keystroke 
combination to create a duplicate worksheet of Dept D. 

 Clean – Clean the new worksheet by deleting the data in the grid area. 
 Relabel – Change the worksheet labels in Cells A1 and on the worksheet tab to read 

“consolidated”. 
 Formula – In cell C5, enter a formula adding the C5 cells in the four budget sheets. The 

formula should look like this: 
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='Dept A'!C5+'Dept B'!C5+'Dept C'!C5+'Dept D'!C5 

 

 Copy – Copy the formula down and across the grid area, and you are done. 
 

2. Using Spearing Formulas To Consolidate Similar Data - The workbook below contains 
identical budgets for Departments A, B, C and D. The goal is to consolidate these 
four budgets into one consolidated budget. 

  

 
 

 CTRL + Drag Tab – Select worksheet labeled “Dept D”. Use the CTRL + Drag Tab keystroke 
combination to create a duplicate worksheet of Dept D. 

 
 Clean – Clean the new worksheet by deleting the data in the grid area. 
 
 Relabel – Change the worksheet labels in Cells A1 and on the worksheet tab to read 

“consolidated”. 
 

 Formula – In cell C5, enter a spearing formula that adds cell C5 cells in the four budget 
sheets. The formula should look like this: 

 
=SUM('Dept A:Dept D'!C5) 

 
I use the mouse to accomplish this step. Start by typing “=SUM(“, then click on cell C5 in 
Dept A, hold the shift key down, and click cell C5 in Dept D.  

 

 Copy – Copy the formula down and across the grid area, and you are done. 
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3. Using the “Data Consolidate Command” To Consolidate Dissimilar Similar Data - The 
workbook below contains dis-similar budgets for Departments A, B, C and D. In other words, 
each worksheet contains some different row descriptions and more or less rows than the 
other worksheets. The goal is to consolidate these four budgets. 

  

 
 

 New Worksheet – Insert a new worksheet. 
 

 Label – Label the new worksheet in Cells A1 and on the worksheet tab to read 
“Consolidated”. 
 

 Select Cell – Select a blank cell such as B5.  
 

 Data, Consolidate – Select Data, Consolidate to display the Consolidate dialog box as 
shown below. Make sure to click the Cell Choose button, then highlight the data only on 
Dept A, click “Enter”, and then click “Add”. Repeat this process for Dept B, C and D. 
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Click the check boxes to use Labels in the “Top Row” and “Left Column”.   
 

 Finish – Click OK to produce the results 
 

 Add Totals - Highlight your data and expand the selection to include a blank bottom 
row and blank right column. Click the AutoSum tool, add formatting and you are done. 

 

 
 

Comments: 
 

 Row Descriptions - Note that the consolidation works only to the extent that the 
different worksheets contain the same row descriptions. Had you department heads 
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used the descriptions Rent, Rent EXP, and Rent Expense, then those rows would not 
actually consolidate but would be shown as three separate rows on the resulting 
consolidation report. 

 

 Account Numbers – As an option, you might insert account numbers to the left of the 
row descriptions to consolidate dissimilar information which contains dis-similar row 
descriptions.  
 

 To Update – To Update the results, place your cursor in the upper left hand corner of 
the Consolidation range, and rerun the Consolidate command. If the resulting report 
is a different size, you will need to add totals or clean up left behind data.  
 

 Consolidate Different Workbooks – Excel can also consolidate data from different 
workbooks. The procedure is exactly the same except that you use the Browse button 
instead of the Cell Chooser button to point to your data ranges.  

 

 
4. Using The “PivotTable Wizard” To Consolidate Dissimilar Similar Data - The workbook below 

contains dis-similar budgets for Departments A, B, C and D. In other words, each worksheet 
contains some different row descriptions and more or less rows than the other worksheets. 
The goal is to consolidate these four budgets. 

  

 
 

 New Worksheet – Insert a new worksheet. 
 

 Label – Label the new worksheet in Cells A1 and on the worksheet tab to read 
“Consolidated”. 
 

 Select Cell – Select a blank cell such as B5.  
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 PivotTable Wizard – In Excel 2007 and excel 2010, you must first customize your Quick 
Access Toolbar and insert the icon titled PivotTable and PivotChart Wizard as shown 
below. This is a hidden tool in Excel 2007 and cannot be used unless you first add it to 
your Quick Access Tool bar. (The Insert PivotTable command in Excel 2007 does not allow 
you to select multiple consolidation ranges).  

 

 
 

 PivotTable – Click the PivotTable and PivotChart Wizard icon to display the PivotTable and 
PivotChart Wizard dialog box as shown below. Choose multiple Consolidation ranges and 
click Next, and Next again. The dialog box on the right should now be displayed. 

 

   
 

Click the Cell Chooser button, then highlight the data only on Dept A, click “Enter”, and 
then click “Add”. Repeat this process for Dept B, C and D. 

 
 Finish – Click “FINISH” to produce the results. 

 

 Add Formatting - Highlight your data and add formatting, then you are done. 
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Comments: 
 

The PivotTable approach is superior to the Data Consolidate approach for many reasons 
as follows: 
 

i. Totals are automatic inserted. 
ii. AutoFilter buttons are automatic inserted. 

iii. If the source data changes, simply click refresh to update. 
iv. The resulting PivotTable is drillable. 
v. The resulting PivotTable can be pivoted. 
vi. The PivotTable report offers many PivotTable tools such as PivotTable formatting 

which Data Consolidate does not offer. 

 
Using Regression to Create Budgets  
 
Excel provides the ability to extrapolate data from your accounting system to produce budgets, 
projections or forecasts using the least squares method of linear regression. The process is 
extremely easy as illustrated in the following example. 
 

A Quick Example:  
 
In this example I have exported the income statements for the past six years from my QuickBooks 
accounting system. The next step is to highlight these five columns (from 2009 through 2013 as 
shown below), and drag the Fill Handle to project 2014 beginning budget values. (Please note 
that in this example I have selected the entire columns and the Fill Handle is shown in the upper 
right hand corner of the selected range.) 
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Using the Fill Handle to Create a Budget for 2014 based on Five Years of Actual Data 

 

Why Does This Work?  
 
But why does this work? How can a simple drag of a mouse create a sophisticated budget? To 
better understand the underlying workings of this concept, let’s start with a more simplified 
example using simple regression. 
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Simple Regression Example: 
 
In the screen below we start with three columns of data for the months of January, February and 
March.  

 
Start with Three Simple Columns of Data 

 
Simply highlight the three columns and drag the Fill Handle out an additional three columns. The 
result is that Excel fills in new columns for April, May and June – including column headings, 
column totals and forecast data, as pictured below.  

 

 
The Fill Handle Uses Regression to Project April, May and June 

 

Explaining Regression: 
 
So where does this new data come from? The answer is that Excel uses linear regression to 
produce this data.  Excel evaluates the data for January, February, and March on a row by row 
basis, and uses this information to project the subsequent variables. To help you better 
understand this concept, here is how regression works from a visual perspective:  
 

1. Once again, a simple example using Excel’s Fill handle. The 8 month’s of data yields a projected 
value of 5,967. 
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2. This time we use the same data, but instead of using the Fill handle, we use the SLOPE and 
INTERCEPT functions to solve for month 9’s projected value. 
 

 
 
As you can see above, the slope and intercept functions produce the exact same result as does 
dragging the Fill Handle, thus proving that the math used by Excel is accurate. 
 

Yet another way to produce the same results is to use the FORECAST function, as follows: 
 

 
 

As you can see in this above example, the FORECAST function also produces the same result as 
the Fill Handle and the SLOPE & INTERCEPT calculations. 

 

All three of these forecast calculations, which produce the same identical values, can be viewed 
visually by creating a Scatter Chart, and then applying a Trendline, as follows: 
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The dotted trend line above is based on linear regression as described in the preceding 
paragraphs. To forecast future values, Excel simply extends this trend line, and then uses the 
intervals of the original data to plot future values, as suggested by the red dotted arrows below. 

 

 
 

Now watch what happens when we base the trendline on logarithmic regression instead of linear 
regression. In the chart below, we see that the trendline is now curving slightly.  

 

 
 

Non-Linear Regression: 
 

Excel provides 5 forms of non-linear regression (as shown in the Trendline Options box in the 
image above) – Exponential, Logarithmic, Polynomial, Power and Moving Average. Collectively, 
these 5 Trendline options are based on different forms of non-linear regression, which is 
explained in detail on this Wikipedia page http://en.wikipedia.org/wiki/Nonlinear_regression. 
The Wikipedia’s explanation is very complicated, but to simplify: non-linear calculations weight 
the data points differently based on their position on the trendline (with linear regression all data 
points are weighted the same). Some mathematicians and CPAs maintain that non-linear 
methods produce more accurate results as more recent data points tend to be more relevant to 
producing a trend than older data points. 
 
You can calculate forecast values in Excel using the Exponential form of regression by using the 
GROWTH function, as follows. 
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Notice that the projected value for month 9 is 5,995.86 using Exponential regression, which in 
this example which is 29.22 higher than the projected value based on linear regression. 
 
The simplest way to forecast values using Exponential regression is to drag the Fill Handle while 
holding down the right mouse button, then selecting Growth from the popup menu as pictured 
below. 
 

 
 

This action will fill in the 9th month with a forecast value based on exponential regression instead 
of linear regression. 
 

LINEST and TREND Functions 
 
Although not used in this case study, you should be aware that Excel provides two additional 
forecasting functions - LINEST and TREND. These functions basically forecast values using linear 
regression exactly like the FORECAST function. The FORECAST and TREND functions are simpler 
to use than LINEST, but the advantage of the LINEST function is that it can also be used as an 
Array function to fill in values for a large range of data. Presented below is a simple example of 
the LINEST function. 
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Data Analysis ToolPak 
 
To use the LINEST function most efficiently, you should first load Excel’s Analysis ToolPak, as 
follows. From the File tab, select Options, Add-Ins. In the Manage box, select Excel Add-ins, then 
click Go. In the Add-Ins dialog box, select the Analysis ToolPak check box, and then click OK. The 
Data Analysis ToolPak will then appear in your Data Ribbon.  
 

 
 
The Data Analysis ToolPak’s Regression analysis tool uses the LINEST function to perform more 
complicated regression analysis which includes controlling the confidence levels and calculating 
and plotting residuals. The screenshot below shows an example of the Analysis ToolPak’s 
Regression tool along (shown in the dialog box) and an example of the output generated by this 
tool beginning in column H. As you can see the output is very complicated, but the resulting 
output can then be used to fine tune various regression calculations.  
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Closer inspection of the ToolPak’s regression tool reveals options for setting the Constant to 
Zero, adjusting the Confidence Level, and utilizing a combination of Residuals, Standardized 
Residuals, Residual Plots, Line Fit Plots, and Normal Probability Plots.  
 

 
 
These detailed aspects of regression are beyond the scope for our particular budgeting purposes, 
but following are links for those that wish to delve further: 
 

1. The 2002 report Using Dummy Variables in Regression by Hun Myoung Park of Indiana 
University (www.iuj.ac.jp/faculty/kucc625/documents/dummy.pdf is a good place to 
start for educating yourself about these variables. 
 

2. This Wikipedia page titled Errors and residuals in statistics goes further in depth into 
residuals. (http://en.wikipedia.org/wiki/Errors_and_residuals_in_statistics) 
 

3. A 6-page Duke University report walking you through an example for using the Data 
Analysis ToolPak’s Regression tool is available here (http://tinyurl.com/cueqap2). 

 

Shortcomings with the Data Analysis ToolPak’s Regression Tool: 
 
To be fair, I should point out that Excel’s ToolPak Regression tool has a number of shortcomings, 
including: 
 

1. Missing Functionality – Other regression tools offer hierarchical regression and case weighting, 
but Excel’s tool does not.  
 

2. Inadequate Diagnostic Charts - Several common diagnostic charts are not included in Excel (for 
example, scatterplot charts, residuals against predicted values, and normality plot of the 
residuals.) Charting typically goes hand-in-hand with forecasting to help visualize the results. 

   
3. No Standardized Coefficients – Without a standardized coefficient, it may be difficult to interpret 

your results.   
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4. Inadequate Diagnostic Statistics – The lack of collinearity diagnostics makes it more difficult to 

understand the forecast data model, although Excel’s PEARSON, RSQAURE and SKEW functions 
could be used to aide in understanding.  

 
Two More Statistical Measures 
 
Two other Excel functions that might also be useful for analyzing the suitability of data for 
regression include KURTOSIS and SKEW, which both measure the symmetry of data along a bell 
curve. For example, data that is perfectly symmetrical will yield a SKEW score of 0 (zero). The 
closer a data’s SKEW is to zero, the less suitable that data is for regression, because the data’s 
trend is considered unreliable, be it trending upwards or downwards. The KURTOSIS works 
similarly, although it’s scoring is different as it is designed to measure multiple peaks, whereas 
the SKEW measures a single Peak. 
 

Alternatives To Regression 
 
If data is found to be inadequate for regression calculations, then other forecasting methods will 
be necessary. For example, you might: 
 

1. Inflation Forecasting - Forecast future amounts based on prior year amounts inflated for inflation, 
increases in the consumer price index, or some other inflation factor. 
 

2. Percentage Forecasting - Forecast future amounts as a percentage of another line item, such as 
sales or payroll. For example, Cost of Goods Sold (COGS) might be forecast as 45% of forecast 
Sales since historically, COGS does approximate that percentage amount. Or you might forecast 
Fringe Benefits as 15% of Payroll since historically, Fringe Benefits do approximate that 
percentage amount. 
 

3. Best Guess Forecasting - You might come up with another forecast amount based on discussions 
with department heads. For example, the training budget might be forecast  much higher than 
regression, inflation, or percentage methods because you know that since the new version of 
Windows 8 and Office 2013 will be implemented, a significantly higher than normal amount of  
training will be needed to bring everyone up to speed on those products. 

   

Detailed Budget Example Using Regression 
 
Starting with Dynamics GP 
 
Now that we’ve discussed the various concepts related to regression, you are now ready to see 
it in action. In this example, we will start by exporting 4 years’ worth of income statement data 
from Dynamics GP to Microsoft Excel (virtually every accounting system on the planet enables 
users to complete this step). In Dynamics GP, we start by printing a 36-month income statement 
to the screen (as pictured below) and exporting it to Excel. 
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Next in Excel, Regression Creates the Initial Budget  
 
Once in Excel, to create the initial budget, select the 36 columns with numeric data, then left click 
and drag the “Fill Handle” out twelve additional columns to create the 2014 budget, as suggested 
below. 
 

  
 

The result is that Excel uses linear regression analysis to predict the future values. Keep in mind 
that this is just an initial starting point.  
 

Budget Totals 
 
Now that we have generated regression amounts, and overwritten those amounts where we 
have more accurate numbers and also those where regression is not suitable, we continue by 
totaling the 12 months to produce the annual 2014 budget amounts, as pictured below. 
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The purpose of totaling the annual budget is so we can adjust the monthly budget for seasonality, 
as discussed below. 
 

Adjusting for Seasonality 
 
Annual budget amounts are not very useful because they do not allow you to compare actual to 
budgeted results on a monthly basis – you must produce monthly budget amounts. However, 
simply dividing an annual budget by 12 to produce monthly amounts is not good enough because 
many line items are typically seasonal.  For example, actual revenue may be twice as high in some 
months compared to other months, but comparing these seasonal sales amounts to a non-
seasonal budget is virtually meaningless because you can’t tell whether you are on target, off 
target, or by how much. Therefore, it is difficult to determine whether corrective measures are 
needed on a month to month basis. 
 
Seasonal budgets make a big difference. I believe one of the primary reasons companies fail to 
properly analyze their budgets to actuals throughout the year is because their budgets are not 
seasonal to begin with, and therefore such comparisons are virtually meaningless.  
 
To add seasonality to your budget; simply spread the annual amount of each budget line item 
across the 12 months based on the ratio of last’s year’s monthly amounts compared to last year’s 
annual amount, as follows. 
 
Start by creating column headings for the seasonal budget, as pictured below. 
 

  
 
Next, enter a formula using last year’s January value (as of January 2013) as a the numerator and 
the SUM of all of 2013’s values as the denominator, and then multiplied times the 2014 annual 
budget amount (=AD6/SUM($AD6:$AO6)*$BB6), as pictured below. 
 

 
 

Notice in this formula I have used dollar signs to anchor the column references so that I may copy 
the formula down and across to complete the seasonality adjustments. 
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Rounding & Formatting 
 
It is rather senseless to produce budgets with pennies, or even dollars; I recommend rounding 
the results by editing the seasonality formula. Edit the seasonality formula adding the ROUND 
function in front of the formula and “-2” to the end of the formula to round to the nearest 
hundredths, as pictured. 
 

 
 
Now recopy this revised formula (overwriting the previous seasonally adjusted budget data) to 
update the budget. 
 

 
 
Finally, select a formatted column (such as column BA in this example) and click the Format 
Painter tool; then highlight the twelve months budget to apply the formatting, as suggested 
below. 
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Always Use Your Better Numbers When You Have Them 
 
(This should be obvious to all, but I will say it anyway…) Of course some budget line items should 
never be forecast using regression or other forecasting methods because they are known 
amounts. For example, regression may suggest that rent expense might be $236,433.12 for 
January 2014, but since I have signed a lease agreement, I know that rent expense will be exactly  
$220,000 for January 2014, so that is the amount I will use. The same goes for known line items 
such as depreciation expense, web-hosting expenses, interest payments on outstanding loans, 
and any other contractually known obligations. You would always use these more accurate 
numbers instead of regression’s projected numbers. 
 

Regression Warning  
 
Regression only works when the underlying data follows a consistent trend. If revenue has grown 
steadily for the past six years, then regression will likely project a reasonable value for year seven. 
However if revenue has jumped all over the board for the past six years, then regression will likely 
give you a worthless projection for year seven.  
 

For example, consider that in the past five years gasoline prices jumped from $1.60 
per gallon to more than $4.00 per gallon. If you use regression to predict gasoline 
prices for future years based on this prior increase, regression will likely predict 
gasoline prices in the $10.00+ per gallon range – but let’s hope that such a 
prediction would be inaccurate – right?  

 

Critical Key Point to Understand 
 
The key point is that regression represents a starting point for many of the budget line items, but 
not all budget line items. In all probability, a combination of forecasting methods will need to be 
applied depending on each particular line item – regression should not be relied upon for all 
forecast data.   

 
Back to the Budget - Overwrite Those Line Items Where You Have Better Numbers 
 
Once we have completed this process, we then insert better numbers on those line items where 
we have better budget amounts. For example, the current lease agreement will provide the most 
accurate amount to use for rent expense. We would use our depreciation schedule to provide 
the most accurate amounts for depreciation expense. For interest expense, we would look to the 
loan amortization schedule to prove these numbers (and so on). However for those numbers 
where you have no better basis to use for budget preparation purposes, why not use linear 
regression analysis to provide the answer? 
 
To accomplish this task, it is best to use the split screen tool to split the screen into four areas so 
you can easily see the row descriptions and column headings for the corresponding budget line 
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items you are working with. (Excel 2013 no longer provides split screen tools on the scroll bars 
as did Excel 2003, 2007 and 2010 – you must click the Split Screen tool icon on the View tab and 
then adjust the splits by dragging them). Now scroll each line item and ask yourself if you have a 
more accurate basis for forecasting that line item, and if so, insert those more accurate values. 
For example, I have inserted new depreciation values (highlighted in grey) in the screenshot 
below. 

 

 
 
Back to the Budget - Document Your Budget Values 
 
For each line item you change, you should document the basis for that budget line item with an 
Excel comment, (or some other method such as an adjacent in-cell comment). For example, in 
the screenshot below, I have inserted Comments next to each account description indicating the 
line item’s forecasting basis. Comments are indicated by small red triangles in the upper right 
corner of a cell and the comment is displayed whenever you hover over the red tick mark with 
your mouse. 
 

 
 

To print comments, select Page Setup from the Page Layout tab, and on the Sheet tab select At 
end of the sheet from the Comments dropdown box, as pictured on the left below. Note that 
the comments do not show up in Print Preview, but they do appear as a printed page at the end 
of your print out; an example of which is pictured on the right below.  

 

http://www.carltoncollins.com/


www.CarltonCollins.com  

Copyright October 2013 – J. Carlton Collins, CPA  Page 27 

  
 

Testing Data’s Suitability for Regression Calculations 
 
Therefore, you should always visit each line item in the projection and consider whether the 
projected values make sense. Excel provides at least two good functions to help you accomplish 
this task – PEARSON and RSQUARE.  For example, in the screen shot below, I have calculated the 
suitability of 5 different sets of data for regression, using both the PEARSON and R SQUARE 
functions.  The first data set on row three has a perfect trend and scores a 100% in both the 
PEARSON and R SQUARE calculations. However, the data sets that follow are comprised of an 
increasingly less perfect trend, and the declining PEARSON and R SQUARE scores reflect this 
decline. 
 

 
 
For example, I might conclude that the first four sets of data were found to have a sufficient trend 
as to provide a suitable basis for regression calculations but that the data set in row 15 does not. 
You should establish your threshold and consistently stick to that threshold. In this case, I might 
require a minimum 60% PEARSON score and 50% R Square score in order to justify reliance on 
that data as a basis for regression forecasting.  
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Back to the Budget - Testing Data for Regression Suitability 
 
Next we will test each line item’s data for regression suitability. This step will help us determine 
which rows, if any, need to be forecast using a method other than regression. We start this 
process by labeling a couple of blank columns Pearson and R Square, then enter the respective 
formulas to test the 36 columns of data row–by–row, as shown below, on the left. 
 

 
 
Notice that both the PEARSON and R SQUARE 
formulas return percentage values that are both 
negative and positive, which means the data is 
trending upward or downward. Since we don’t care 
which direction the data is trending, (we only care 
that it scores high), we can edit the formulas to 
include the ABSOLUTE function (ABS) which 
changes all amounts to positive numbers, as 
picture above on the right. 
 
Now we can set our thresholds to minimum scores, 
let’s say 50% (Pearson) and 40% (R Square) for 
example, then apply conditional formatting to flush 
out those line items that meet our stated criteria. 
As pictured to the right, those line items in columns 
BB and BC containing formatting are not suitable 
for regression based on our stated criterion level, 
and another forecasting method will need to be 
used to forecast those amounts. For example, we 
may simply use last year’s number inflated by the 
consumer price index. 
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Budgeting Balance Sheets and Cash Flow 
 
In many cases, budgets consist of a profit and loss statement only, but I believe this falls short.  
 
By creating a budgeted balance sheet and cash flow statement, (which requires the creation of a 
budgeted balance sheet), a company can truly monitor expected results for every account, 
including the all-important cash flow balance. The process starts by forecasting the balance sheet 
and once created, forecasting cash flow is a simple matter of crunching the numbers.  
 
To produce a budgeted balance sheet, assumptions are needed related to the days in accounts 
receivable, accounts payable and inventory. These day calculations are best derived by examining 
the historical days in accounts receivable, accounts payable and inventory for recent years, and 
using those amounts as a guide. For example: 
 

1. AR - The budgeted accounts receivable balance may be calculated as 46 days of the prior month’s 
sales. 
  

2. AP - The budgeted accounts payable balance may be calculated as 28 days of the prior month’s 
variable expenses. 
 

3. Inventory - The budgeted inventory balance may be calculated as 62 days of the prior month’s 

COGS amount. 
 

4. Loan Payments – Loan repayments should be budgeted based on the actual amortization 
schedules, based on the principle payment amounts.  
 

5. And so on. 
 
Once the balance sheet items have been budgeted, the resulting cash flow budget is computed 
as follows: 
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The area in yellow (rows 5 through 19) shows the profit and loss budget as projected using the 
methods described earlier above. The blue area (rows 21 through 25) depicts the assumptions 
and the changes in balance sheet balances. The green areas (rows 26 through 32) represent the 
forecast balance sheets and cash flow forecast. Because the income statement is seasonalized, 
the balance sheet balances and cash flow forecast will also be seasonalized.  
 

This Income Statement Budget Is Not Yet Completed 
 
At this point, we have prepared a complete monthly budget using regression supplemented with 
other forecasting methods, and this effort may be sufficient for your needs. However, please be 
aware that this budget example was simplified in order to more easily convey Excel’s regression 
tools and concepts. There is more to the process for those truly dedicated to creating the most 
accurate budget possible – keep reading.  
 

Forecasting Revenue 
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In the example above, for the purpose of explaining regression as simply as possible, I treated 
the budgeting process for revenue exactly the same as the budgeting process for expenses, but 
in reality budgeting revenue is usually a different process from budgeting expenses.  
 
For established companies, many projected expenses can be reasonably determined using 
regression, inflation, percentage of sales or best guess forecasting methods. However, revenue 
is subject to far greater external factors such as competition, marketing, the state of the 
economy, inflationary pressures, changing attitudes, etc. For example, the appearance of a new 
competitor in the marketplace could steal away market share and thus negatively impact 
revenue. For example, in late 2012 Apple shares fell from $700 a share to almost $400 a share 
for no other reason than the prospects that Microsoft’s, Google’s and Samsung’s new tablet PC 
offerings were expected to eat into Apple’s market share.  
 
Negative press related to the quality of your product (such as the gas pedal sticking for Toyotas) 
could adversely affect sales. By contrast, your product may become wildly popular if a well know 
celebrity starts wearing or using your product. A good marketing campaign can help significantly, 
or hurt if it happens to make the wrong impression.  
 
The point is that regression is unable to incorporate factors like this, therefore a more detailed 
forecasting approach is usually needed. A good budget will consider all of the relevant factors 
and in the end, you may produce multiple budgets given differing anticipated scenarios. 
 

Simple Example of Revenue Projection Based on Units 
 
In the following example, Crazy Fred’s has listed the number of training courses scheduled for 
each month of the budget year, and has projected attendance for each month based on the 
average attendance achieved in previous years for those same months. Crazy Fred charges a 
course fee of $100 per attendee, which is input in cell A8. Crazy Fred also knows that the fixed 
cost of printing the training manual and having the food catered will be $22 and $27, respectively 
– as input into cells A11 and A12. 
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Notice that this projection method does is not based on historical revenue amounts, only 
historical attendance figures have been used. In this example, the company knows how many 
classroom venues have been booked and has a fairly decent idea as to what attendance might 
be; therefore, regression based on historical revenue amounts would not be as accurate as using 
these known quantities to forecast revenues.  
 
A more sophisticated example of forecasting revenues based on units of production is shown 
below. In this example, a CPA firm has listed each employee along with each employee’s 
budgeted billable hours and billing rates by month.  

 
 
In this example, projected revenue is again based upon units rather than historical revenue 
amounts, as regression methods applied to historical revenue amounts would likely yield less 
accurate projections. 
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Keep in mind that revenue is often more volatile than expenses. An effective marketing program 
might increase the number of units sold, a bad economy might adversely affect the number of 
units sold. Any foreseen or expected events like these should be incorporated into the budget 
and explained in detail.   
 
In conclusion, while the regression example above was used to forecast both revenue and 
expenses, in many cases regression should probably only be used as a means of forecasting 
expenses only.  
 

Calculating Your Desired Profit Margin  
 
It is also useful for companies to budget and monitor their profit margins; a profit margin that 
misses its target speaks volumes. Once established, budget to actual profit margin comparisons 
can also be used as benchmarks to help detect fraud, errors or irregularities.  
 
To calculate your desired profit margin, I suggest that you work backwards by asking yourself (or 
your client) two simple questions, as follows: 
 

1. How much do you think revenue will be next year? 
2. How much profit do you want to make? 

For example:  
 
Let’s assume that Burt has owned and operated a construction company store for the past 17 
years. As his CPA, I ask him two questions as follows: How much profit do you want to make next 
year and how much sales do you anticipate next year?  
 

Burt responds – “that’s easy, we’ve been growing at 8% a year for the past five 
years and last year (2013) we nearly reached $12 million sales, so we will probably 
hit $13 million in revenue next year (2014). Also, I’d like to make a million dollars 
profit – I think that’s a reasonable goal.”  

 
With just this little bit of data, we can work backwards based on Burt’s prior year financial 
statements and advise him as follows:  
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Burt’s fixed costs are a little more than $6 million in 2012, but let’s say that we can adjust 
this amount down to $5,200,000 because the company was able to renegotiate and sign 
a new lease agreement. The point is that we are using 2012’s fixed cost amount along 
with any known adjustments. This allows us to work backwards to calculate the projected 
Gross Margin of $6,200,000. 
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From here we can compute Cost of Goods Sold, and then divide Cost of Goods Sold and 
Gross Margin by Sales to derive the desired Profit Margin that will cover Fixed Costs, 
Variable Costs and still have the desired Net Income of $1,000,000 left over.  In 
conclusion, a Profit Margin of 47.7%will yield the desired results.  
 

 
 

Now that the optimum profit margin is known, let’s say that further analysis reveals that 
the inventory and labor items on average are priced at just 44.5% above cost, as the 
following calculations show, net income for 2014 would only be expected to reach 
$585,000 – well below Burt’s desired profit. 
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At this point, you need to convince Burt of the importance of pricing his products and 
services at the desired profit margin in an effort to target the desired results. To convey 
this point, you will tell Burt the following laughable story about the Florida boys who 
started a business in Gainesville, Florida selling onions. It goes like this:  

 
These two Florida boys were running up to Georgia and buying Vidalia onions at 4 for 
$1.00 which they then took back to Gainesville and sold for a quarter a piece on the 
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streets. The business was an instant success and soon those boys found themselves selling 
from a road side stand, to a small store, to a much bigger store. The customers kept 
coming and the business kept getting bigger. Soon they had customers lined up around 
the block to buy those onions, which they kept buying 4 for a dollar and selling for 25 
cents apiece.  
 
After six months, one Florida boy turned to the other and said – “you know, business is 
great! But I don’t think we’re making any money – what do you think we should do?” The 
other Florida boy thought real hard and then blurted – “I think we need a bigger truck.” 
  

OK, it’s an old exaggerated story, but there is a lesson to be learned here. If you don’t price your 
products to make a profit, you will never make a profit. And, if you don’t price your products to 
make your desired profit, you will never make your desired profits. In our example above, Burt 
should consider setting his margin pricing to target a profit margin of 47.7%, instead of the 
current profit margin of 44.5% to ensure a chance of achieving his desired goals. Without this 
measure, Burt has absolutely no chance of reaching his goals, unless his revenue estimate is 
wildly under-stated.  
 
To be sure, if Burt’s costs go up or down, his prices will need to be adjusted accordingly to provide 
the desired profit margin. But when you think about it, this approach is one in which Burt sells 
his goods and services to his customers at the lowest price point possible that covers his fixed 
costs, variable costs, and desired profit – and not a penny more. It seems reasonable that every 
company in the world strive for this goal - right? 
 
Here’s a simplified way to look at this - suppose your business was to purchase candy bars for 
resell. Your only options are to sell the candy bars for: 
 

A. Below cost. 
B. At cost. 
C. At cost plus your desired profit. 
D. At cost plus an egregiously high profit. 
E. At cost plus some random profit that may or may not be sufficient. 

 
I can’t see how any reasonable person could select any option other then C – yet I see many 
companies sell their products based on all of these scenarios because they don’t take time to 
calculate their desired profit margin, and then monitor that amount throughout the year.  
 
You can download this Profit margin template at www.CarltonCollins.com/profitmargin.xlxs. 
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Budgeting and Financial Reporting Concepts in Excel: 
 

2. The Importance Of A Budget – Most of the company’s I deal with either do not prepare 
a budget, or do not use their budget to compare their actual monthly results throughout 
the year. They seem to prepare a budget as if to “check the task off the list”, and then 
refer to the budget gain at year-end and declare “oh well, we missed it”. A budget is not 
just a document that sets out expenses, it also sets out revenue and profits. Companies 
should keep this in mind and purposely plan for their desired profit. If the budget is 
reasonable, then it should be followed carefully, compared to ongoing results to 
determine if the company is on target to het the budget, and if not, point out those areas 
that need addressing in time to make corrective measures.  
 

3. Most People Start With Prior Year Numbers And Work From There – In most cases, prior 
year actual results are a great place to start when preparing next year’s budget. Simply 
round the figures and visit each line item asking yourself how much that line is expected 
to increase or decrease, and adjust accordingly.  
 

4. Exporting Your Prior Year Trial Balance To Excel – While there are several respected 
budgeting tools in the marketplace, excel is by far the most popular and most flexible tool 
to use. Most accounting systems can export monthly actual amounts to Excel. From there, 
the =ROUND() function can be applied to round the numbers. After that, inflation 
formulas designed to increase or decrease line items can be used to adjust the numbers. 
Alternatively, expenses can be projected as a percentage of revenue, or as a multiple of 
some statistical account such as hours worked or units produced. 
  

5. Creating A Budget Preparation Template – In many cases CPAs prepare budget templates 
and send them out to department managers to fill in. Once completed the budgets are 
routed back to the CPA who then consolidates the results. This can be a good approach 
to take. To ensure that the results received are complete and accurate, and easily 
consolidated, the CPA should produce a well prepared template that is very clear, and 
contains the proper verbiage and field names, and column headings so that the end 
results are consistent. If the CPA receives a hodgepodge of mismatched data, then 
consolidating the data, or even making sense of it might be difficult. 

 
6. Delegating Budget Preparation And Sending A Template – When budget templates are 

prepared and distributed, the CPA should pay close attention to the directions for 
completing the budget, and timeframe for delivering the results. Because this approach 
makes the CPA’s budget preparation dependent upon the deliverables of others, clear 
directions, milestones, and continuous follow up are critical.  

 
7. Create Budgets By Month – Annual budgets are not very useful as a tool because they 

make it difficult to monitor actual versus budget results throughout the year. Simply 
dividing an annual budget by 12 is not a very good approach either, because many line 
items are subject to seasonality.  For example, actual revenue may be twice as high in 
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some months compared to other months, but comparing these seasonal sales amounts 
to a non-seasonal budget is virtually meaningless because you can’t tell whether you are 
on target, off target, or by how much. Therefore it is difficult to determine if corrective 
measures are needed on a month to month basis. 
 

 
8. Budgeting Revenue Is Different From Budgeting Expenses – For established companies, 

projected expenses are reasonably known, or can be reasonably determined. However, 
revenue is subject to far greater external factors such as competition, marketing, 
inflationary pressures, changing attitudes, etc. A new competitor into the marketplace 
could eat into your revenue. Negative press related to the quality of your product (such 
as the gas pedal sticking for Toyotas) could adversely affect sales. By contrast, your 
product may become wildly popular if a well know celebrity starts wearing or using your 
product. A good marketing campaign can help significantly, or hurt if it happens to make 
the wrong impression. The point is that a good budget will consider all of the relevant 
factors and in the end, you may produce multiple budgets given differing anticipated 
scenarios. 
   

9. Start By Analyzing The Seasonality Of Your Revenue For Past Years – Seasonal budgets 
make all the difference in the world. I believe one of the primary reasons companies don’t 
analyze their budgets to actuals throughout the year is because their budgets weren’t 
seasonal to begin with, and therefore the comparison was virtually meaningless. You 
could start by calculating the percentage of a given line item’s expense that occurs on a 
month-to-month basis. If the answers each year consistently show percentages 
significantly below or above 8.33% for a given month, then congratulations, you’ve just 
detected a seasonal lump or dip in your budget, and the percentage to use in predicting 
that same lump or dip next year. 

 
10. Forecast Balance Sheets And Cash Flow Too – Too often budgets consist of a profit and 

loss statement, but this falls short. Companies are advised to create a budgeted cash flow 
statement as well, (which implies the creation of a budgeted balance sheet). Once the 
budget balance sheet items have been created, the budgeted cash flow budget is a simple 
matter of crunching the numbers. To produce a budgeted balance sheet, assumptions are 
needed related to the days in accounts receivable, accounts payable and inventory. These 
day calculations are best derived by examining the days in accounts receivable, accounts 
payable and inventory for recent years, and using those amounts as a guide. 

 
11. Budgeting The Profit and Hence, Profit Margin – When was the last time you asked your 

company or client “How much  profit would you like to make? Once the company or client 
determines the desired profit, and expected revenue is reasonable projected you can 
calculate the necessary profit margin required to achieve the desired profit margin. 
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12. Using Regression To Create Budgets - Excel provides the ability to extrapolate data from 
your accounting system to produce budgets, projections or forecasts using the least 
squares method of linear regression analysis. The process is extremely easy as follows. 
 
In this example we start by exporting 3 year’s worth of monthly trial balance data from 
Dynamics GP to Microsoft Excel. In Dynamics we have printed the report to the screen 
and also to a comma separated value print file. 
 

 
 
This same data is then opened in Excel as shown in the following screen. I have deleted 
the balance sheet account line items and inserted a column called Category to help tidy 
the data.  
 

http://www.carltoncollins.com/


www.CarltonCollins.com  

Copyright October 2013 – J. Carlton Collins, CPA  Page 41 

 
 
To create a budget for 2009, we will start by using the Subtotals Tool located on the Data 
Ribbon. This action inserts subtotals in each column below each change in the category 
column. 
 

 

 
 

Next we collapse the outline to display only row totals and use the “Select Visible Cells 
Tool” to select the visible data in Excel. With only the subtotal and grand total rows 
displayed, we apply a color and then expand the outline. The result is that formatting has 
been applied to the subtotal and grand total rows to make them easier to read. 
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To create the budget, select the 36 columns with numeric data, then click and drag the 
“Fill Handle” out twelve additional columns to create the 2009 budget as shown below. 
 

 
 

The result is that Excel uses linear regression analysis to predict the future values. Once 
you have completed this process you should insert better numbers on those line items 
where you have better budget amounts. For example, you would look to the lease 
agreement to determine the best amount to use for rent expense. You would use your 
depreciation schedule to provide numbers for depreciation expense. However for those 
numbers where you have no better basis to use for budget preparation purposes, why 
not use Linear Regression Analysis to provide the answer. 
 
After all numbers have been updated, use the =ROUND() function to duplicate the budget 
on a separate workbook with all amounts properly rounded. Format as desired, label the 
budget appropriately, and you are done. A complete monthly budget prepared in less 

The Fill Handle 

Drag Out 12 Columns 
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than 5 minutes. The great news now is that same budget can be imported back into 
Dynamics GP without reentering the data.  

 
 

13. Rounding Budgets – The ROUND() function rounds a number to a specified number of 
digits. For example, if cell A1 contains 237825, and you want to round that value to the 
nearest thousands, you can use the following formula in cell C1:  
 

 
 
Note: To round a number to a specific multiple (for example, to round to the nearest 
0.5), use the MROUND function. 
 

 
14. No Embedded Assumptions In Formulas – It is always a good rule to not embed 

assumptions in your Excel formulas. The reason is that doing so makes it more difficult to 
later find those assumptions to change them, and unsuspecting users in the future 
(including yourself) may forget that there are embedded assumptions and they could 
accidentally render subsequent budgets inaccurate.  
 

  
        Wrong     Correct 
 

15. Explain All Underlying Assumptions Thoroughly – It may be obvious to all when you are 
preparing a budget as to where the assumptions come from. However, later the source 
of those assumptions may not be so obvious. For this reason, the diligent CPA will 
document all assumptions and formulas used so that they and others can easily follow 
the logic later.  Explanations can be documented in a variety of ways as follows: 
 

 On an administrative page 

 Next to the assumption in a cell 

 Next to the assumption as a comment 

 Next to the assumption as a Data Validation Comment 

 Next to the assumption using a balloon call out 
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16. Administrative Page – For complex workbooks that are referred to frequently or used by 
others, it is a good idea to include an administrative page that helps the reader 
understand and navigate the workbook. Following is a list of potential elements you might 
add to your workbook administrative page: 
 

 The name of the company or client to which the workbook pertains 

 The date the workbook was first crated, and notes related to subsequent 
enhancements 

 Table of contents with hyperlinks to the various contents 

 Macro buttons for easier printing of the various reports 

 A list of authors and reviewers contributing to the template 

 An explanation of the purpose of the workbook 

 An explanation of the assumptions used in the workbooks 

 Links to external data sources referenced in the workbook 
 
Read on to see an example and learn more about creating an administrative page. 
 

17. Using Hyperlinks to Navigate Budgets – As budgets are created, the various calculations 
tend to be based on data assembled from a variety of sources. In my opinion, all of the 
underlying calculations and source data used to create a budget should be included in the 
budget workbook along with the final budget, which might make the workbook 
somewhat cluttered. Therefore, the budget, calculations, data should not only be 
organized and well-labeled, but a hyperlinked table of contents should be inserted to aide 
in navigating the workbook, like the table of contents shown below.   
 

 
 

To create a hyperlinked table of contents, list the various sections of your workbook in a 
table of contents format as shown above, then select each line and click Ctrl+K to assign 
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a hyperlink to that line. Notice below that the Insert Hyperlink dialog box allows you to 
assign a hyperlink to worksheets, cells, or defined names in the workbook.  
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18. Using Macro Buttons to Print Budgets – You can make the budget workbook easier to use 
by inserting macro buttons to print the various reports. To start this process, create a single text 
box, and use the Drawing Tools to make it look fancy as indicated in the screens below: 
 

      
 

Create the Print Macro – Next create a print macro by selecting “Macro, Record Macro” from the 
“View Ribbon” (make sure that no spaces are used in your macro name and save the macro to 
“This Workbook). Set the “Print Area” appropriately to display your full budget area. Next simply 
print the full budget, then stop recording the macro by selecting “Macro, Stop Recording” from 
the “View Ribbon”. Once completed assign the Macro to the Print Sales Order Button by right 
mouse clicking and selecting “Assign Macro”.   The right click menu and the Assign Macro Dialog 
box are shown in the two screens below. 
 

      
 

Additional Macro Buttons – Next right click on the edge of the existing macro button 
twice, and or press Ctrl+C to copy it; then click away from the button and Paste the button 
several times. This will create exact copies of your macro button. (You must right click 
twice on the edge of the button to display the second menu of options.)  
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Next on the Home tab in the Editing group, select Find and Select, Select Objects. Then 
lasso the three buttons and from the Drawing Tools tab, use the alignment tools to Left 
Justify and Distribute Vertically the macro buttons. 

 

        
 

The results will appear as follows: 
 

 
 

Press escape to deselect the “Object Pointer” tool, and return your cursor to normal. In 
the future, when you want to print any portion of your budget workbook, just click the 
appropriate buttons to produce the desired reports. 

 
19. Grouping Budget Data - To group and summarize your budget, you can create an outline 

of up to eight levels, by row or by column. Once grouped, you can show or hide detailed 
data by selecting the desired outline level as circled in the screen below. To group data, 
simply highlight the rows or columns to be grouped, and select Group from the Data tab. 
The resulting grouped data will appear as follows: 
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If you data contains subtotals or grand totals (limited to 8 levels of subtotals), then Excel 
can automatically apply groups for you. To use this feature, select Auto Outline from the 
Group dropdown arrow, as shown below. 
 

 
 

20. Producing Budget To Actual Comparison Reports – There are several approaches to 
comparing actual to budget data, as follows: 

 
a. Side-by-side reports, with difference and difference percentage calculations. 

Probably my favorite approach personally. To improve this function, consider 
grouping the data. 
 

b. Side-by-side columns, with difference and difference percentage columns. This 
might be a better approach in some situations.  

 
c. Over and Under reports, with difference calculations. These reports are much 

harder to compare in my opinion, but many CPAs seem to use this approach. 
 

d. Side-by-side reports, with Data Bar Formatting applied to difference and 
difference percentage calculations. While extreme data can throw off the data 
bars, in many situations data bar formatting helps you quickly identify that data 
that needs further scrutiny. 

 
e. Reports without subtotals so data can be filtered, subtotaled and pivoted. 

Removing formula subtotals and inserting data subtotals is not as hard as you 
might think. In this example we will number the rows, use =RIGHT() to identify the 
subtotal rows, sort, delete the unwanted rows, then resort in order according to 
our numbered rows. This is a time-honored method used frequently by many CPAs 
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to clean data and prepare it for analysis. From here, I will demonstrate filtering, 
subtotaling and pivoting the data as well.   

 
An Excel 2010 file containing examples of these types of comparisons is available for 
download on my web site at www.ASAResearch.com/web/actual.xlsx, or just navigate 
to the file using on the Excel tab menu. Example screen shots are shown below: 
 

A.  
 

B.   
 
C. (Not Pictured) 
 

D.  
 

E.  

http://www.carltoncollins.com/
http://www.asaresearch.com/web/actual.xlsx


www.CarltonCollins.com  

Copyright October 2013 – J. Carlton Collins, CPA  Page 50 

 
As these examples illustrate, comparison reports are usually large and often confusing to 
construct and navigate. Any of the approaches described above may be suitable than the 
others, depending upon the data, situation and personal preference. Hopefully, 
knowledge of all of these approaches will be helpful to you.   
 

21. Adding Columns to Pivot Tables – Many CPAs frequently ask how to add new columns to 
PivotTables, so here is the solution: Click a cell in your PivotTable to select it, then on the 
PivotTable Tools tab, select Options; Calculations; Fields, Items & Sets; Calculated Field. 
In the resulting Insert calculated Fields dialog box, build the desired formula and click the 
add button. For example in the screen below, I have inserted the following  formula into 
the Formula box =January Budget-January Actual. (Note that the Excel Formula text box 
does a poor job of allowing you to view the complete formula).  
 

 
 

When completed, click the Add button to insert a new column in the PivotTable. To 
complete the task, double click on the title of the new column and provide a new name 
that better describes the column. 
 

22. Investigate Overages – Of course, any amount that exceeds the budget significantly 
should be investigated to determine the cause of the overage. A number of common 
explanations include: 
 

a. The costs went up. 
b. The company over purchased. 
c. The company double paid. 
d. There was a posting error. 

 
A big worry CPAs should worry about is that the line item contains irrelevant data that 
should have been posted elsewhere, but was posted to the account as a measure to 
hide fraudulent activity. For example, a bookkeeper writing fraudulent checks to their 
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relative might try to hide those expenses in the repairs account, a place where more 
one-time payments seem to occur. 
 

23. Investigate Under Spending – It might be easy to assume that an actual amount well 
under budget is good news, but that is not usually the case. In most cases under budget 
items are caused by errors or perhaps the company failed to pay a vendor their rightful 
fee. At a minimum this situation might suggest poor budgeting assumptions which 
should be avoided the following year. 
 

24. Revise Budgets Throughout The Year As Needed - As conditions change, your initial 
budget may be rendered obsolete. For example, an epic disaster such as a hurricane or 
tsunami may have a tremendous impact on a charitable organization’s donations and 
expenditures, rendering old budgets obsolete. In such instances, it is prudent to generate 
revised budgets to follow for the remainder of the year. Economic conditions can change 
multiple times throughout the year and they often do. For this reason, it is more realistic 
to consider the budgeting process to be an ongoing process, rather than a one-time event, 
which occurs at the beginning of each year.  

 
25. Importing Budgets From Excel Into Your Accounting System – Most accounting systems 

provide the ability to import a budget directly into the accounting system from Excel. In 
most cases, the user must abide by the following rules: 
 

a. The Excel budget is typically saved as a comma separated value (CSV) file format, 
and this CSV file is imported into the accounting software system. 
 

b. The account numbers used in the Excel based budget must be an exact match to 
those in the accounting system in order for the import to work completely and 
correctly.   

 
c. Typically, the column heading labels in the Excel budget must match exactly the 

field names in the accounting system.   
 

d. In most cases, the easiest procedure is to first export a budget from your 
accounting system to Excel, and the resulting Excel file will contain all the correct 
account numbers and column headings. From this point, the user need only copy, 
paste or move the budget data to its correct position before creating the CSV file. 

 
e. Some accounting systems such as SAP R/3, have the ability to display budgets in 

an Excel format enabling the users to edit the budget directly in Excel. Thereafter, 
as the Excel file is saved, the data is automatically updated in the accounting 
system.  
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26. Excel Functions Useful For Budgeting – When creating budgets, the following functions 
are typically more useful than the others, and you should keep them in mind as you 
proceed with the budgeting process. 
 
a. SUBTOTAL - Returns a subtotal in a list or database 
b. VLOOKUP - Looks in the first column of an array and returns a cell on that row 
c. HLOOKUP - Looks in the top row of an array and returns the value of the indicated cell 
d. MATCH - Looks up values in a reference or array 
e. TRIM - Removes spaces from text 
f. LEFT - Returns the leftmost characters from a text value 
g. RIGHT - Returns the rightmost characters from a text value 
h. MID - Returns a specific number of characters from a text string starting at the position you specify 
i. FIND - Finds one text value within another (case-sensitive) 
j. CONCATENATE - Joins several text items into one text item 
k. CLEAN - Removes all nonprintable characters from text 
l. ROUND - Rounds a number to a specified number of digits 
m. ROUNDDOWN - Rounds a number down, toward zero 
n. ROUNDUP - Rounds a number up, away from zero 

 
27. Charting Budget versus Actual Results – Charts can often be an effect method for 

comparing actual verses budgeted data. Presented below is an example: 
 

 
 
In this example, I have avoided using 3D chart and rotation. I have also reduced the Gap 
between the data bars which effectively makes the data bars wider. The flat chart is 
slightly easier to read than line charts or 3-D chart (because 3-D charts distort the data a 
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little, and make comparisons a little more difficult.) The same chart above is presented 
below as both a line chart and 3-D chart. 
 

      
 

28. How Charts Lie – Charts are useful tools for visualizing and analyzing data. However, 
charts can sometimes be deceiving, and CPAs should be aware of this when creating or 
reading charts. Below are examples of charting methods that may distort data. 
 
Rotating 3-D charts. The two charts shown below are identical, except for rotation. The 
red pie slice facing forward covers 107% more area (graphically) than the pie slice facing 
the rear. This technique might subliminally give the impression that the red pie slice 
represents a larger or smaller portion of the pie, depending upon your perspective. 
 

 
Picture charts. The chart below shows sales results for three salespersons. The chart 
shows that the third salesperson generated three times the amount of sales of the first 
salesperson ($3,000 compared with $1,000). Reading the chart based on data bar height, 
the chart reads accurately. However, because the data bars in the chart are taller and 
wider, the third data bar covers nine times the surface area of the first data bar, thus 
creating the illusion that sales were nine times higher.  
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3-D bar charts. The two charts below are identical, except for the 3-D effect. Notice that 
in the 3-D chart, the third data bar representing 4,000 does not appear to reach the 4,000 
hash mark on the Y-axis. By comparison, the same data bar displayed in a two-
dimensional version of the chart does perceptibly touch the 4,000 hash mark. (The reason 
for this distortion is that the front of the 3-D bar lines up with the Y-axis labels on the left 
side of the chart, but the data bar’s depth is not as great as the 3-D chart’s depth.) 
 

 
Cone charts. The two charts atop the next column are identical, except for the “cone” 
effect. Notice in the 3-D bar chart on the left, meals and entertainment expenses appear 
to represent a significant portion of the total travel expenses. However, in the cone chart 
on the right, meals and entertainment expenses visually appear to represent a much 
smaller fraction of the total travel expenses. 
 

 
 

Distorted line charts using 3-D and rotation. The three charts below depict the same 
data. The first chart is a two-dimensional line chart, which suggests an overall downward 
trend in the data. The second chart is also a two-dimensional line chart, but the maximum 
value on the Y-axis has been increased tenfold compared to the first chart, thus flattening 
the line and suggesting that there is not much of a trend in the data. The third chart is a 
3-D line chart, which has been rotated forward to emphasize the increase at the end of 
the chart. This third chart might give more of an impression that results are trending 
upward. 
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Reverse order charts. In the chart on the next page, the data are displayed chronologically 
from right to left. In this example, revenue has actually declined over the past three years; 
however, since most people read charts from left to right, they might miss the fact that 
the data is presented in the opposite direction. 
 
 

 
 
Armed with this information, you are in a better position to prepare and read charts 
without falling into distortion traps.  
 

29. Managing Review and Approvals – In terms of preparing an Excel-based budget, one of 
the issues you should address is documentation of the preparation, review and approval 
of that budget. As the preparer, this means that a sufficient amount of documentation 
should be provided related to who prepared the budget, the assumptions used, when the 
budget was prepared, noted regarding changes made since the initial rough draft version, 
suggestions contributed but not used, etc. Once the budget goes to review, more notes 
should be added as to who conducted the review and what their findings were. Additional 
notes regarding how review points were handled should also be included in the 
workbook. I think this is obvious to all, yet I seldom see those notes included in budgets.  
 
The bigger issue is how does the reviewer know that once reviewed, the data is  not 
changed further. The answer is that the workbook must be Shared so that future changes 
can be tracked.  To use this feature, from the Review tab, select Share Workbook form 
the Changes group, and click the Allow Changes checkbox as shown below.  
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Once you have shared the workbook, all changes made by yourself and others are tracked 
in Excel. Therefore, upon the next review, the reviewer will be able to tell which cells have 
changed (and how) and which cells have not changed. This makes subsequent reviews 
much easier. To track changes, from the Review tab, select Track Changes, Accept or 
Reject from the Changes group.  The following dialog box will appear.  
 

 
 

Select the changes you want to review based on the date range in which the changes were 
made, who made the changes, and even in a selected portion of the workbook. Click OK. 
This action will launch the Accept or Reject Changes dialog box shown below, and will 
navigate to each change one at a time allowing the reviewer to click the accept button to 
keep the change and mark it as reviewed, or reject the change.  
 

 
 
Another reviewer approach that is sometimes used is to insert comments at various 
points in the worksheet as an approval sign off, an example of which is shown below.  
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30. Protecting the Integrity of the Budget – In a famous case from the 1990’s, a disgruntled 
employee who had just been fired before leaving his office reportedly opened an Excel 
based budget for a proposed highway project, and changed the amount of concrete 
required from 50 million cubic yards to just 5 million cubic yards. The change was made 
after the budget had been reviewed and approved, and the employee’s subsequent 
change was not detected. The bid was sent and the company was awarded the contract. 
The error was noticed months later as project managers compared the actual costs to the 
budget and projected a significant loss on the job. The company was able to compare the 
budget submitted to a printed version of the approved budget where they discovered 
how the problem occurred.    
 
To protect a workbook, it is a good idea to first Share the workbook so that you can track 
all changes and who made them. To further protect data to help prevent it from being 
changed, you can also specify a password that users must enter to modify the workbook. 
In addition, additional advanced protection settings also allow you to prevent users from 
changing the structure of a worksheet. 
 
Protecting A Worksheet - By default, when you protect a worksheet, all the cells on the 
worksheet are locked, and users cannot make any changes to a locked cell. If desired, you 
can unlock specific cells using the Format Cells dialog box prior to turning on worksheet 
protection. You can unlock cells for all users or for specific users. When you protect a 
worksheet or workbook, adding a password is optional. Once protected, the user must 
physically unprotect the worksheet (using the password if necessary) in order to make 
changes to locked cells. Presented below are both the protect Worksheet and Protect 
Workbook tools in Excel. 
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31. Sharing a Workbook in the Cloud – Microsoft’s new Azure platform allows you to save 

your Excel Workbook to the Azure cloud, and others located anywhere in the world can 
access the workbook, provided they have the correct login name and password. The 
following video provides a short demonstration of this functionality: 
 

http://office.microsoft.com/en-us/videos/video-share-a-workbook-in-the-cloud-VA101267318.aspx?CTT=1 

 
32. Copying Across the Excel Page – When creating budgets, the user often has a need to 

copy formulas or data across long columns in which arrowing down thousands of rows 
takes too much time. In this situation, there are two possible approaches you can use – 
the piggyback approach and the end-down-back approach. These approaches are 
explained as follows: 
 

a. Piggyback Approach – (Use an adjacent column to navigate.) For example, assume 
you want to copy a formula in cell D2 down to the next 48,000 blank cells. Column 
A contains 48,000 row labels, which can be piggy-backed. In this example, copy 
cell D2, then move to cell D3. Next, holding the Shift  key down, press the LEFT  
ARROW 3 times to navigate to cell A3, then press the END, DOWN ARROW to 
navigate to the bottom of column A, then press the RIGHT ARROW three times to 
navigate across to cell D48001. Release the Shift key. You have now selected the 
range in column D from cell D3 to D48001. Paste to complete the operation. 

 
b. End-Down-Back Approach – (Use the bottom of the worksheet to navigate.) For 

example, once again assume you want to copy a formula in cell D2 down to the 
next 48,000 blank cells. Column A contains approximately 48,000 row labels, but 
there are too many blank cells to use that column for piggy-back purposes. In this 
example, copy cell D2, then move to cell D3. Next, holding the Shift key down, 
press the END, DOWN ARROW to navigate to the bottom of the worksheet – cell 
D1048575. Next press the LEFT AROOW three times to navigate to column A, then 
Press END, UP ARROW to navigate to the last label in Column A – cell A48001. 
Press the RIGHT ARROW three times to navigate across to cell D48001. Release 
the Shift key. You have now selected the range in column D from cell D3 to 
D48001. Paste to complete the operation. 

 
33. Using Ratios Create Budgets – Many companies produce budgets in which at least some 

of the line items (such as Cost of Goods Sold) are projected as a percentage of Sales (or 
some other metric). For example, a company may examine its historical Cost of Goods 
Sold and calculate those costs to consistently be approximately 42.3% of sales. If the 
results are consistent over time, then such percentages might be a good basis for 
preparing budgets in the future. For this reason, companies should examine their 
historical data in an effort to identify line items that may be budgeted in this manner, and 
if so, determine the appropriate percentage to use.  
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This can be particularly useful for those new startup companies, or companies budgeting 
new ventures. Metric information is available from many sources that may provide 
insights into projected costs for budgeting purposes. 
 

34. Budgeting Units Of Production Or Hours To Be Billed – Similar to budgeting by 
percentages, many companies produce budgets in which at least some of the line items 
are based on projected units of sale. In this case, the company starts by projecting units 
of sale and then ties revenue and expense items to those sales. For example, a training 
company may charge $100 per person to attend a training course, and the primary costs 
may consist of $22 per person for each set of materials, and $27 per person for breakfast, 
lunch and snack costs.  
 

 
 

35. Hiding Data in Excel – Be aware that data cannot be hidden in Excel. Even if you hide 
columns containing sensitive data and turn on worksheet and workbook protection. A 
user could reveal that hidden data in one of the following ways: 

 
a. A user could select a range of columns that contains hidden columns, then copy 

and paste that data to reveal the hidden data in another workbook. 
 

b. A user could link to a hidden cell from another workbook, simply by typing a 
formula linking to that hidden cell.  

 
36. Copying Down with Ctrl+D – The Ctrl+D keystroke combination can be a quick way to 

copy data. To use this shortcut, highlight the cell you want to copy and the blank cells 
underneath where you want to paste, and press Ctrl+D, as shown below. 
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37. Using Split Screen – Excel 2007 and 2010 contain two Split tools, which allow you to 
quickly split the Excel worksheet horizontally, vertically, or both. The Split tools make it 
easier to view and compare different portions of your data at the same time. To split your 
screen, click and drag the split tools to the desired positions. The Split tools are located 
in the upper right-hand corner and lower right-hand corner of the worksheet area in the 
scroll bars, as shown below. 
 

     
 

You can also access this tool by selecting Split from the Window group on the View 
Ribbon. Many users find the click-and-drag method a little faster and easier to use than 
the menu method. In the example below, the Vertical Split tool has been used to display 
data for the first quarters of 2009 and 2010. (Notice that the columns jump from column 
E to column O). Additionally, the Horizontal Split tool has been used to fix the column 
headings at the top of the worksheet. (Notice that the row numbers jump from row 3 to 
row 7.) 
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Note: There are several alternative strategies for viewing Excel data side-by-side as 
follows: 
 

a. Freeze Panes. You can achieve similar results to Split by using Freeze Panes, 
located in the Windows group on the View Ribbon. 
 

b. Second instance of Excel. You can also achieve similar results by launching a 
second instance of Excel and using it to open a second (read-only) copy of your 
Excel file. You can then resize both instances of Excel in side-by-side windows. 

 
c. Formulas. For a more permanent solution, some CPAs use formulas to repeat data 

on a separate worksheet to produce a different view. For example, on Sheet2 they 
may insert formulas that refer to data in columns A, B and C next to other formulas 
that refer to columns M, N and O. Using this approach, the side-by-side 
comparison is always available without the need for the above-mentioned manual 
procedures. 

 
38.  Using Excel Zoom - In Excel 2003, 2007 and 2010, you can zoom in and out instantly by 

holding down the Ctrl key while rolling the wheel on your scrolling mouse. This approach 
is faster and allows you to zoom up to a 400% view, down to a 10% view— and any option 
in between. This works in Microsoft Word, too. Microsoft Office 2007 and 2010 both 
include a sliding Zoom tool at the bottom right-hand corner of the screen that 
accomplishes the same result. 
 

 
 

39. Sticky Format Painter - Double-clicking on the Format Painter icon will cause it to stick, so that 
you can continue to apply the desired format to multiple cells, ranges, columns or worksheets. To 
turn off this effect, either press the Esc key or click the Format Painter icon. 

 

 

40. Absolute/relative referencing - Pressing the F4 key while in edit mode will insert absolute 
dollar sign references, which is an easier method than manually typing in the absolute 
dollar sign references. To do this, select a cell that contains a formula, and press the F2 
key to enter edit mode. Within the formula, position the cursor over a cell reference and 
press the F4 key to insert absolute references. Before and after examples are shown 
below. 
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(Note: Pressing the F4 key repeatedly will toggle you through the available absolute 
reference options—column only; row only; both column and row; or none.) 

 
41. Hide Zero Values - You can hide all of the zero values in a worksheet by adjusting Excel’s 

options as follows: 
 

a. In Excel 2003, select Tools, Options. On the View tab, uncheck the Zero values 
box and click OK. 
 

b. In Excel 2007, select the Office Button, Excel Options, Advanced. Under the 
Display options for this worksheet section, uncheck the box labeled Show a zero 
in cells that have zero value and click OK. 

 
c. In Excel 2010, select File, Options, Advanced. Under the Display options for this 

worksheet section, uncheck the box labeled Show a zero in cells that have zero 
value and click OK. 

 

42. Display Zero Values As A Dash - You can display zero values in your worksheet as a dash 
by changing the cell’s format to either the Accounting or Comma Style format. 

 

 

43. Black Parenthesis - When building a complex formula that contains nested functions or 
multiple sets of parenthesis, Excel uses colors to help you identify parenthesis pairing, 
and the outside parenthesis are always black. This tip can help you determine whether 
you have inserted the proper number of parenthesis pairs in your formula. 
 

 

44. Using Excel’s New Slicer (Excel 2010 Only) - Slicer is an enhancement to Excel 2010’s 
PivotTables that inserts filter boxes that your superiors can click to display precisely the 
reports they desire. To use slicer, position your cursor anywhere in a PivotTable report 
and, from the Insert tab, select Slicer from the Filter group. This action will open the Insert 
Slicers dialog box shown below. 
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Place a checkmark in the box for each slicer you want to display and click OK. Excel will 
insert Slicer dialog boxes containing filter buttons into the worksheet for each field name 
you select, as shown in the example below.  

 

 

Simply click the various filter buttons to display different views of your data. For example, 
the second report in the next column summarizes revenue for those “Dine In” and “Drive 
Thru” restaurants managed by “Caroline” and “Madison” in the “Atlantic” and “Great 
Lakes” regions. (Holding down the Ctrl key allows you to make multiple selections within 
a Slicer dialog box.) The selected filter buttons are highlighted, and the non-selected filter 
buttons are grayed out, allowing you to see which filters have been applied to the report. 
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In the example shown above, the reader could produce up to 720 views of this one report 
(9 States × 4 Types × 4 Territories × 5 Sales Reps). In your situation, you could add three 
similar PivotTable reports summarizing your data by week, month and quarter, and e-mail 
the entire workbook to your superiors. This would limit the total number of reports you 
would need to prepare to just four, while providing your superiors the ability to view the 
data thousands of ways, according to their preference. 

 
Advanced tip: A slicer can be shared with multiple PivotTable reports so that when filters 
are applied in one slicer, multiple Pivot Table reports are filtered. To share a slicer, click 
on the slicer to be shared to display the Slicer Tools, Options tab. In the Slicer group, 
select PivotTable Connections and place a checkmark next to the PivotTables you want 
to share the slicer as shown below. 

 

 

Hint: You can resize and reposition your slicers on the worksheet, and apply matching 
styles to both the PivotTables and slicers to produce professional-looking results. 
 

45. E-Mailing a Single Excel Worksheet - You can send a single worksheet (that is, not the 
entire workbook) from within Excel using the integrated Outlook Send this Sheet applet, 
as follows: 
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a. Launch the E-Mail dialog box tool as follows: Excel 2003—Select File, Send to, Mail 
Recipient (for Review). Excel 2007 and 2010—To access the E-Mail dialog box in 
Excel 2007 and 2010, you must first add the tool to your Quick Access Toolbar. To 
do this, right-click on the Quick Access Toolbar and select Customize Quick Access 
Toolbar. In the Choose commands from: dropdown box, select Commands Not in 
the Ribbon. Scroll down and select Send to Mail Recipient, and click the Add>> 
button to include this command on your Quick Access Toolbar. Click OK. Click the 
Send to Mail Recipient icon on the Quick Access Toolbar. 

 
b. In the E-mail dialog box, select the radio button labeled Send the current sheet as 

the message body, and click OK. 
 

 

c. This action will create an e-mail using the worksheet contents as the e-mail 
message. Indicate the e-mail recipients and subject as you would normally when 
preparing an e-mail message and click Send this Sheet. 

 

 

The Send this Sheet menu is integrated with Outlook so that the To…, Cc…, and Bcc… 
dropdown fields will display the contacts and contact groups you maintain in Outlook. 
Once the e-mail is sent, a copy appears in your Sent Items box, similar to that of a regular 
e-mail. 
 
Cautionary note 1: When using the Send the current sheet as the message body option, 
the Excel data is converted from an Excel format into a table format containing only 
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values. To send a single worksheet with the Excel formulas intact, make a copy of the 
workbook, delete all of the worksheets except for the one you intend to send, and repeat 
the steps above using the Send the entire workbook as an attachment option. 
 
Cautionary note 2: Note that this approach does not provide the full functionality of 
Outlook; for example, this method does not automatically insert your default signature 
block. 
 
Cautionary note 3: This functionality works well with Outlook, but does not necessarily 
work with other e-mail client applications. 
 

46. Duplicating a Worksheet or Worksheets - Excel 2003, 2007 and 2010 allow you to 
duplicate a worksheet by holding the Ctrl key down and dragging the worksheet’s tab to 
the left or right. This action will insert a new worksheet, complete with the same headers, 
footers, margins, column widths, and cell contents, as the original worksheet. (In many 
situations, this method is quicker and easier than inserting a new worksheet and then 
adding headers, footers, margin settings and content.) 
 

 

Alternative approach: To achieve the same results using the menus, select a worksheet 
tab (or group of tabs), right-click on that worksheet tab (or group of tabs), select Move or 
Copy from the pop-up menu, check the Create a copy box, and click OK. 
 
Hint 1: Using the menu approach described above, you could also copy and create a 
duplicate worksheet in another workbook. 
 
Hint 2: To duplicate multiple worksheets at the same time, select the first worksheet to 
be duplicated by clicking on the worksheet tab. Next, while holding down the Shift key, 
select the last worksheet to be duplicated by clicking on its tab. (This action will select 
those two tabs and all worksheet tabs in between.) Copy the group of worksheets by 
holding the Ctrl key down and dragging the group of worksheet tabs to the left or right. 
 

47. Displaying Two Digit Years - Many of the default settings in Excel, including the date 
format, are governed by the default settings in the Windows operating system, as 
pictured in the screen below. 
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These default settings can be modified as follows: 
 
1. In Windows XP, launch Control Panel and double-click the Regional and Language 
Options icon, then click the Customize button to open the Customize Regional Options 
dialog box. On the Date tab, click the Short date format: dropdown arrow in the Short 
date group and select a two-digit date format. Click OK, OK to complete the process. 
 
2. In Windows Vista, launch Control Panel and select System and Maintenance. Next, 
from the left-hand menu select Clock, Language, and Region, then Regional and 
Language Options, then click the Customize this format button to open the Customize 
Regional Options dialog box. On the Date tab, click the Short date: dropdown arrow in 
the Date formats group and select a two-digit date format. Click OK, OK to complete the 
process. 
 
3. In Windows 7, launch Control Panel and select System and Security. Next, from the 
left-hand menu, select Clock, Language, and Region, then Region and Language, then 
click the Additional settings button to open the Customize Format dialog box. On the 
Date tab, click the Short date: dropdown arrow in the Date formats group and select a 
two-digit date format. Click OK, OK to complete the process. 
 
Note: You must close and restart Excel for any changes to take effect. Thereafter, Excel 
will display the two-digit date format you specified as the default. 
 
Cautionary point: It is important to understand that even when you are displaying two-
digit years, you should still make it a habit to enter four-digit years, otherwise Excel may 
assume the wrong century. This is because Excel interprets two-digit years ending in 00 
through 29 as years 2000 through 2029. (For example, if you type the date 6/2/20, Excel 
assumes the date is June 2, 2020.) However, Excel interprets two-digit years ending in 30 
through 99 as years 1930 through 1999. (For example, if you type the date 6/2/60, Excel 
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assumes the date is June 2, 1960.) You can change the way Excel interprets two-digit years 
by adjusting the Calendar setting located at the bottom of the Customize Regional 
Options dialog box (shown in the left-hand column). 
 

48. Hiding and Unhiding Columns - To unhide a specific column in Excel 2003, 2007 or 2010, 
press the F5 key to launch the Go To dialog box and type in any cell address within the 
hidden column that you wish to unhide (such as G1), and click OK. This will place your 
cursor within column G, even if hidden. Next, while holding down the Alt key, type in 
order O, C, U to unhide the column. 

 
Alternatives. Once you have highlighted a column as described above, there are many 
alternatives for unhiding columns, several of which are presented below so you can use 
the approach that works best for you. 
 
1. Using the menu. To unhide a column using the menu in Excel 2007 and 2010, from the 
Home tab, select Format from the Cells group, Hide & Unhide, Unhide Columns. To 
unhide a column using the menu in Excel 2003, select Column, Unhide from the Format 
menu. 
 
2. Using the unhide shortcut. In Excel 2003, 2007 and 2010, Windows XP users can unhide 
a column by typing Ctrl+Shift+0, but this keystroke combination is inactive by default in 
Windows Vista and Windows 7. (Hint: Microsoft support document 967893 describes 
advanced procedures to enable this keystroke combination to work properly in Windows 
Vista or Windows 7.) 
 
3. Adjusting column width. Instead of unhiding a column, you could simply increase the 
column width to make it visible. To do this, start by pressing the F5 key to open the Go To 
dialog box and enter a cell address to go to a hidden column. To resize column widths in 
Excel 2007 and 2010, from the Home tab, select Format from the Cells group, Column 
Width, enter the desired width, and click OK. To resize a column width in Excel 2003, from 
the Format menu select Column, Width, enter the desired width, and click OK. 
 
Advanced hint: You can make your task easier by assigning a name to a cell in each column 
you wish to hide or unhide using the Name Box (located just above the Column A 
heading). For example, you might assign the name YTD to cell G1, and the name Budget 
to cell H1. This will make it easier for you to use the Go To command because the name 
makes it more obvious which column is which. Further, you could also use the Name Box 
to assign a name to a group of columns, and use the same procedure described above to 
hide or unhide that group. For example, you might assign the name PriorYear to cells J1 
through M1, and use the Go To command to go to those columns and unhide the entire 
lot. 

 
49. Custom Views - Rather than constantly hiding and unhiding columns, a better approach 

might be to use the Custom Views feature in Excel 2003, 2007 and 2010. By creating 
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custom views, you can easily toggle back and forth between all of your views. To create 
your first custom view, select Custom Views from the View tab or menu, click the Add 
button and enter a description in the Name box, then click OK. Next, hide or unhide 
various columns in your workbook and repeat these steps to create a second view of your 
data that includes selected hidden columns. Continue to create additional custom views 
for each of your desired hidden column layouts. Thereafter, you can reduce or eliminate 
the need to hide and unhide columns by simply changing views. To toggle between 
custom views, from the View tab, select Custom Views in the Workbook Views group, 
and double-click the desired custom view as shown below. 

 

 

50. Displaying different tab from the same Excel worksheet on two monitors - This can be 
accomplished. Start by displaying Excel across both monitors as follows: Click the Restore 
Down button in the upper-right corner of the Excel window. Hover the mouse over either 
the left or right edge of the Excel window until it becomes a double arrow and drag the 
edge of the Excel window across both monitors. 

 
With Excel now spanning two monitors, display two views of the same workbook in Excel 
2007 or 2010 by selecting New Window from the View menu, then select Arrange All, 
Tiled, OK, also from the View menu. In Excel 2003, select New Window from the Window 
menu, then select Arrange, Tiled, OK also from the Window menu. This will allow you to 
view multiple worksheets from the same workbook side by side on two monitors. In this 
situation, each window will scroll independently and best of all, updates entered into one 
window will automatically update the other windows.  

 
Note: This feature works well on monitors of the same size with the same resolution 
settings, but can yield unpredictable results if monitor size or resolution settings differ. 
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Hint: To ignore other workbooks you have open, and arrange the windows for your 
current workbook only, check the Windows of active workbook box in the Arrange 
Windows dialog box in Excel 2010 (shown above), or the Arrange All dialog box in Excel 
2007. 
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Chapter 2  

Carlton’s Do’s and 
Don’ts of Financial 

Reporting 
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Carlton’s Do’s and Don’ts of Financial Reporting 
You’ve probably read a thousand financial statements in your lifetime, and scoff at the idea that 
there could more to it than you already know. Nonetheless, here are my fifteen rules for 
preparing, delivering, reading and analyzing financial statements and reports.   
 
The Whole Point is Financial Reporting 
 
Financial Reporting is the most important function of an accounting system. According to the 
Intermediate Accounting textbook written by Keiso and Weygandt, “the primary objective of an 
accounting system is to summarize detailed transactional data into useful reports that 
management can use to run their business". Many businesses seem to miss this point as financial 
statements and reports are rarely produced, distributed and read on a continual basis. I believe 
that it is the job of the CPA to implement a financial reporting system that accomplishes the 
following: 
 

1. Ensure that the company’s accounting system produces accurate financial reports. 
2. Ensure that the appropriate reports are produced on a daily, weekly, and monthly basis. 
3. Ensure that those reports are distributed to the appropriate personnel. 
4. Ensure that the appropriate personnel understand how to read the reports. 
5. Ensure that the appropriate personnel are reading the reports and using the information. 

 
Too often businesses produce financial reports only after year end, far too late to allow 
executives to monitor manage the business. There is great information in those reports, and an 
informed management team will make better decisions. 
 
Achieve The Best Reporting Possible 
 
Given the above importance of producing financial statements and reports, it is not enough to 
merely produce a few summary reports. To achieve the best possible results, a wide variety of 
reports must be produced to meet a wide variety of information needs. Accordingly, the checklist 
below is intended to help you achieve the best possible financial reporting for your company or 
client. 

 
1. One Number, By Itself, Is Almost Meaningless 

 
If I told you that I spent $266,548 on Contract labor last month, could you tell me whether 
that was good or bad? No you couldn’t. You would probably follow by asking “How much 
did you expect to spent? Oh, a budget? Sure, we have a budget and we expected to spend 
$293,200 on Contract Labor. From these two numbers you could deduce that we were 
under budget and that is a good. 
 
You might also ask me how much did you spend last month on Contract Labor, or the 
same month last year? Oh, historical amounts. Sure I can tell you that we spent $234,562 
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last month on Contract Labor and $214,036 the same month last year. Based on this new 
information, you might deduce that Contract Labor costs are up dramatically this month 
compared to historical numbers.  
 
The next time you find yourself producing a single column financial report, rethink your 
decision. Adding historical and budget comparison data could make the report far more 
meaningful. Consider the two examples below. 
 

     
      Less informative       More informative 
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2. Difference Reporting  
 
Displaying comparison data is helpful, but such 
comparisons should also be accompanied by “Differences” 
to make it easier for the reader to comprehend, absorb 
and analyze the data. In the example below, columns have 
been added to show the differences between actual 
amounts compared to budget and historical amounts.  
 

 
 
You might think that this tip is obvious, however I see comparison financial statements 
and reports displayed all the time with no such comparison calculations. Without the 
difference calculations, the reader is forced to make mental calculations in their head 
which takes more time and is more prone to error.  
 
Let’s remind ourselves that the goal of producing financial reports is to help management 
make decisions to manage the company.  
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3. Difference Percentage Reporting  
 
In some cases numerical data is more informative than percentage data; however in other 
cases just the opposite is true. Why not provide both? It is helpful to display differences 
as both a numerical and percentage amount. Remember the goal is to make it easier for 
the reader to comprehend, absorb and analyze the data.  Consider the following data: 
 

 
 
In this example, take a look at the difference column. Immediately Partner Salary draws 
catch your attention because it is a whopping $172,000 over budget. However, the $844 
overage for Equipment Rental barely catches your attention. However, when you analyze 
the Difference Percentage column, you immediately see that Equipment Rental is 169% 
over budget. The point is that you should consider both – look for actual amounts that 
grossly exceed your budgets in term so amounts and percentage differences, and 
concentrate more of your analytical efforts on these amounts.  
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4. Budgeting & Revised Budgets  
 

I used to view the budgeting process as a wasteful little 
chore that caused everybody grief and provided little 
benefit. But that view was based on bad budgeting – of 
course if you don’t do it right, poor budgeting is a big 
waste of time. However, if done correctly, budgeting 
can be one of the best measures you can take to help 
manage and run your business. Presented below is a checklist to help you ensure that 
budgeting is performed correctly in your organization. 

 

1. Integrated – Your budget system should be integrated with your accounting system, and 
not maintained in an outside budgeting system such a an Excel workbook. This ensures 
that the accounting system can then produce the necessary budget-to-actual 
comparative financial reports on a regular basis. 

 
2. Stratified - Budgets should be well-stratified (or categorized multiple ways). For example, 

budget data may be categorized by month (or reporting period), by segments (such as 
departments, locations, funds, etc.) and by projects or programs.  

 
3. Revisions – As conditions change, your initial budget may be rendered obsolete. For 

example, an epic disaster such as a hurricane or tsunami may have a tremendous impact 
on a charitable organization’s donations and expenditures, rendering old budgets 
obsolete. In such instances, it is prudent to generate revised budgets to follow for the 
remainder of the year. Economic conditions can change multiple times throughout the 
year and they often do. For this reason it is more realistic to consider the budgeting 
process to be an ongoing process, rather than a one-time event which occurs at the 
beginning of each year. 

 
4. Reporting – Budget amounts should flow easily to, and be included in financial reports. 

Your accounting system should produce a wide variety of comparative reports such as 
“actual-to-budget” comparisons, “budget-to-prior-year-budget” comparisons, and 
“actual and budget to budget-revision” comparisons. These reports should also present 
differences in amounts and percentages, by row; and should be available across separate 
segments such as departments, divisions, funds, etc). 

 
5. Roll Up – Budgets should be created by levels, and rolled up into various levels of 

reporting. For example, a world-wide charity with hundreds of locations would typically 
maintain separate departmental budgets for each location; by state, region, and country. 
The accounting system should allow the entity to roll up all actual and budgetary data to 
produce reports by location, state, region, and country.  

 
6. Statistical Amounts – It is often useful for an organization to budget non-financial 

amounts in addition to financial amounts. Non-financial amounts are commonly known 
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as “statistical amounts”.  As examples, a homeless shelter might budget the number of 
residents they expect to serve, or the number of meals they expect to provide; an 
association might budget the number of new members they expect to recruit; a charity 
might budget the number of magazine subscriptions they expect to sell.  

 
7. Variable Budgeting – Associated with the ability to track statistical data is the ability to 

produce variable budgets – budgets that adjust themselves automatically based on 
certain levels, such as statistical data. For example, as a charitable organization sells more 
light bulbs, the organization’s revenues and expenditures adjust automatically based on 
the number of light bulbs sold. 

 
8. Budgeting Activities – In addition to budgeting financial and statistical amounts, some 

budgeting systems allow for the budgeting of specific activities, campaigns, and capital 
projects. 

 
9. Tools – To aid in the budgeting process, it is helpful for the system to provide user tools 

for inputting budget data. For example some systems enable the user to input one 
amount for the first month, and that amount can then be automatically replicated, or 
increased by a fixed percentage or amount, to fill in the remaining months.  

 
10. Balance Sheet Budgeting – In addition to budget revenues and expenditures, many not-

for-profit organizations find it necessary to budget balance sheet items such as cash and 
receivables as well.  

 
11. Import from Spreadsheet – Microsoft Excel is the world’s most popular tool for creating 

budgets and therefore a good budgeting system will support the importing of data from 
this environment.  
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5. Per Unit Budgeting and Per Unit Reporting 
 
In many instances, it may be helpful to also display 
financial information based on the “Per Unit” cost. This 
is because revenues and costs can vary from one month 
to the next due to volume. As volumes fluctuate, the 
process of comparing actual numbers to budget or 
historical numbers can be completely meaningless. 
However, the process of comparing actual Per Unit Revenue and Costs to Budgeted or 
Historical Per Unit Revenue and Costs can provide meaningful insights into your data. 
Listed below are a few industries in which volume can fluctuate widely from one month 
to the next depending upon many factors.  
 

Manufacturer – Per Units Produced 
Dentist – Per Number of Visits 
Doctor or CPA Firm – Per Hours Billed 
Airline – Per Number of Passengers Served 
Builder – Per Number of Houses Constructed 
Swimming Poll Cleaner – Per Number of Swimming Pools Cleaned 
Hotdog Restaurant – Number of hotdogs served 

 
This type of “Per Unit” revenue & cost accounting analysis can be revealing and 
informative. Consider the example below in which the Per Unit columns show which line 
items are askew when analyzed on a per unit basis. 
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6. As a Percentage of Sales Reporting 
 
Many industries do not produce units or measure 
units that may be used as a basis for calculating Per 
Unit Revenue and Costs; however, their Sales may still 
fluctuate widely enough from one month to the next 
as to make month to month comparisons rather 
meaningless. In this case, it may be meaningful to use 
a “Percentage of Sales” calculation to analyze and 
compare costs from one month to the next.  
 
For example, the financial report below displays financial data as well as “Percentage of 
Sales” calculations. Further, the final four columns calculate the percentage amount by 
which budgeted and prior month “Percentage of Sales” calculations differ from actual 
“Percentage of Sales” calculations. These changes are then highlighted by “Data Bar 
Formatting” to help the reader quickly identify those actual “Percentage of Sales” line 
items that fluctuate significantly from budget or prior month “Percentage of Sales” 
calculations. 
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7. Industry Metrics & Benchmarks 
 
Another approach to comparing data is to compare actual results to financial benchmarks 
of similar companies of similar sizes. Consider the following true story that occurred in 
1998. 
 
 

In 1998 I was installing a new accounting system for a southeastern 
aluminum products company. During the installation I noticed that its 
days-in-inventory level had risen from 72 and 75 days in 1995 and 1996, to 
143 and 152 days in 1997 and 1998 respectively. Perplexed, I visited the 
local library to consult Moody’s Industrial Guide where I looked up the 
typical days in inventory for a company of that size and in that SIC code. 
This guide confirmed that average days in inventory for a company of this 
nature was 76.2 days.  
 

At that time, the company’s inventory level was valued at 
$4,635,000, but a simple math calculation revealed that the inventory level 
should have been closer to $2,323,600 (4,635,000 / 152 * 76.2). Indeed for 
the previous two years the company’s inventory was approximately 
$2,238,200 high compared to similar companies. At the time the 
company’s interest rate on its’ inventory note was 12.5% which means that 
the company had paid interest of $559,600 just to carry the additional 
inventory.   

  
 One of the reasons that management failed to detect the excess 
inventory was because no one was monitoring financial ratios. A manager 
told me that he was aware that inventory levels had increased along with 
sales and he assumed—incorrectly, as it turned out—that inventory was 
increasing in proportion to increases in sales. An investigation revealed 
that the company’s new purchasing agent who had been hire two years 
earlier simply over ordered inventory so that the they would not run out. 
This made the project managers within the company very happy as they 
did not have to deal with inventory arriving just in time in order for them 
to meet their deadlines.  
 
 The manager then explained to me that not only did the company 
needlessly spend $559,600 in excess interest in order to carry the extra 
inventory, but in fact the company had already broken ground on a new 
$4,000,000 warehouse which they now determined was not really needed.    
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There are many sources for obtaining financial benchmark 
information, and in many cases you may have to pay for that 
information. A few example sources for benchmark 
information are listed below: 

 
Moody's Financial Metrics Key Ratios by Rating and Industry: 
2009 

 
 
 
 
 

 
 

 
 

http://www.bizminer.com/reports/samples/industry-
financial.pdf  

 
 

http://benchmark.kpilibrary.com ($20 per month) 
 

http://www.finlistics.com/BenchmarkingTopDownArticle.html  
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8. Ratio Analysis 
 

In many companies, ratio reporting appears to be a lost art form. However, ratios can be very 
revealing, especially if monitored over time. You can find a good listing of the various financial 
ratio calculations commonly used in the Wikipedia at this address: 
 

http://en.wikipedia.org/wiki/Financial_ratio 
 
If time permitted, I would probably cover numerous ratios, show you the formulas and 
explain what they each mean. However, as CPAs, you already know about ratios. My key point 
is that it’s time to start using them. I am deeply saddened to find that virtually none of the 
accounting software products out there actually calculate financial ratios – BusinessWorks is 
one of the few. Instead I will provide you with this true story from 1981: 
 

 
In 1981 I took an internship with ITT Rayonier where it was my job to use 

Arthur Anderson’s Transaction Flow Analysis (TFA) technique to trace the flow of 
documents in the accounting systems of pulp mills. I was assigned to the pulp mill 
in Jesup, GA – (Yes I spent a whole summer in Jesup, GA, commuting each day 
from Saint Simons island).  
 

During my work I calculated the chip yield for the previous 10 years. The 
chip yield is calculated by dividing the tons of paper that is produced by the pulp 
mill by the tons of pulp wood that are delivered to the pulp mill. The results 
showed that the chip yield had fallen as shown in the chart below. 
 

 
 

I called my supervisor in Connecticut and reported the findings, and he told 
me “Carlton, there is a reason for that and if you don’t do anything else this 
summer, I want you to find it an explanation”. I spent the next several weeks 
looking for answers, however no one I talked to could explain the variation. Finally, 
one hot summer day I walked across the mill yard and interviewed a seasoned 
worker who knew the answer. The older gentlemen worked the scales and 
weighed each train car as it came in to deliver pulpwood. It was his job to record 
the weight of the train car full of pulpwood, and then subtract the stenciled weight 
on the side of the rail car to determine the total amount of pulpwood received.  
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For nearly five years this gentleman had noticed when the empty trains came 
back across the scales, the stenciled weight on many of the railroad cars was 
understated. That meant that he was reporting too much pulpwood had been 
delivered. For example, he would weigh a railcar in at 66 tons, and then subtract 
the stenciled weight of 23 tons to calculate the amount of pulpwood received (43 
tons). However, the railcar actually weighed closer to 26 tons, which meant that 
the pulp mill was over paying for 3 tons of pulpwood that they never actually 
received. The scale worker had saved notes on the nearly 250 offending railcars. I 
was able to use his notes to recalculate the true amount of pulpwood received 
and the chip years calculations returned to normal. ITT Rayonier was able to go 
back to the supplier and collect approximately $250,000 in overpayments from 
that supplier.  
 
  

 
This story underscores the importance of calculating key ratios over time, and analyzing them 
for consistency. The actual ratios you calculate will vary depending upon the nature of your 
company, but at a minimum I recommend that you calculate the following ratios with 
regularity: 
 

1. Days in accounts payable 
2. Days in accounts receivable 
3. Days in inventory 
4. Gross profit margin percentage 
5. Current ratio 
6. Quick ratio 
7. Debt to equity 
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9. Event Triggered Reporting (Alarms) 

 
All businesses should ideally employ a team of accountants dedicated exclusively to reviewing 
the company's books and financial statements continuously in order to identify potential 
problems. For example, if cash balance drops below a certain level, if profit margin 
percentages dip dangerously low, or if sales taper off suddenly, warning bells should be 
sounded and management should be alerted quickly so they can initiate corrective measures. 
Historically, this process has been out of reach for most companies, as manual accounting 
systems required the need for hundreds of continuous boring calculations, which rendered 
such a solution unreasonable. 
 
However, with the advent of the computer, the evolution of application software, and the 
addition of e-mail, today's accounting systems can perform hundreds of business calculations 
continuously, comparing the results against pre-set conditions in order to identify emerging 
problems or trends. Once identified, these business alerts can be sent to the appropriate 
management personnel through e-mail, fax, or even a mobile phone. This type of reporting 
is known in programming circles as "Event-Triggered Reporting," "Alarms," or "Alerts." In 
business circles, this type of reporting is known as "Management by Exception." By any name, 
this type of reporting is being heralded as the most useful type of reporting on the planet 
today—and thanks to advancements in technology, this solution is now widely available to 
all businesses. 
 
Six Advantages of Event-Triggered Reporting 
 
Event-triggered reporting holds many advantages over the more traditional type of reporting, 
which typically involves the production of periodic financial statements and reports—usually 
thick, voluminous stacks of financial statements and reports. A summary of key advantages 
of event-triggered reporting is presented below. 
 
1. Immediate Reporting - Event-triggered reports alert the appropriate personnel to 

emerging financial conditions as they occur. For example, if profit margins slip, the CFO is 
notified of this event immediately—often within a few seconds. The more traditional 
monthly reporting approach might mean the CFO receives this information in report 
format several weeks later, and even then there's the chance the CFO won't notice this 
particular event simply by perusing the financial statements. 
 

2. Continuous Monitoring - Even the most diligent of employees will grow tired of 
constantly computing ratios and measures in search of significant observations or signs 
of trouble. However, an automated accounting system does not get bored—it can 
calculate numbers without tiring. 
 

3. Filtered Information - The traditional approach of producing and circulating detailed 
financial reports often inundate management with mountains of information which they 
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must wade through in order to ferret out useful information. This process can be tedious 
and time consuming. By contrast, event-triggered reporting only provides people the 
information they need to act upon. 
 

4. Efficiency - Event-triggered reporting helps people work more efficiently. For example, 
assume a customer's purchases decline for a given period. Traditionally, the sales 
manager might sift through a 400-page sales report in order to identify a customer with 
declining activity. Such laborious tasks are often set aside or even discarded. An event-
triggered reporting system instantly notifies the sales manager whenever activity for a 
given customer slips. The sales manager need only act on the information—mountains of 
paperwork are thereby avoided, or at least reduced. 
 

5. Benchmarking - When it comes to accounting, no single number is useful. To be useful, it 
must first be compared to another number. For example, knowing a company has 80 days 
worth of inventory is virtually useless. You must also fill the blanks to questions such as:  

 
• What was the number of days in inventory last month? Last quarter? Last year?  
• What is the average days in inventory for a company of our size and industry? 
• What is our budgeted days in inventory?  

  
Once a manager knows the days in inventory had been averaging 70 days over the past 
year, the industry average is 65 days, and the budgeted amount is 72 days, a call to action 
to reduce the current 80 day amount is evident. Event-triggered reporting is about 
comparing current financial conditions with benchmarks—hence, all information 
produced by this reporting process is concise and beneficial. 

  
6. Targeted Feedback - Event-triggered reports typically send notifications to only those people who 

should be privy to the information. While the CFO may be copied on all event triggered reports, 
the sales manager may see only those notifications relevant to his or her job. Likewise, the 
president may be copied on notifications pertaining to sales, cash, and profits, but may not be 
bothered with notifications indicating a particular inventory item needs to be re-ordered. 

  
Not Just Looking for Trouble 
 
One might assume event-triggered reporting might focus on looking for potential problems 
and troubling trends, and indeed, event-triggered reporting is well-suited for this goal. 
However, event-triggered reporting can be just as useful for identifying positive events as 
well. For example, a sales manager might want to be alerted when a customer has earned a 
new discount threshold. In this occurrence, the sales manager might receive the following e-
mail message from the alerts system: 
 

Attention Sales Manager: Please call Julia Stevens and congratulate her for purchasing 
$50,000 this calendar year and earning an extra 1 percent discount on all future 
purchases. Her telephone number is 555-0100. 
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Think how much easier your job could be if your accounting system kept you well informed 
of key events such as this. Other examples might include notification of an employee who 
achieved a perfect attendance record for the year, sales representatives who have exceeded 
their goals, or a collections manager who has set a new record for the lowest days in accounts 
receivable. 
 
Unlimited Business Alerts 
 
An unlimited number of possible alert conditions exist that might help a company better 
manage its customers, vendors, employees, and resources. All companies would most likely 
want to monitor typical benchmarks, such as cash levels, current ratios, days in inventory, 
accounts receivable, and accounts payable. They would also employ this solution to keep an 
eye on profits, interest rates, and sales levels as well. However, the accounting system can 
also alert companies about particular inventory items whose quantity are running low, 
customers who are paying too slow, or even employees who have exceeded their vacation 
and sick time quotas. The creative CFO can set up hundreds of pre-set parameters in just a 
few hours, and thereafter, the accounting system will constantly compare these conditions 
to actual results without fail for years to come. 
 
Sage ACCPAC Pro ERP, for example, not only monitors custom events, but it can alert mangers 
by sending them e-mails. As you would expect, many high-end accounting products—the so-
called beginning enterprise resource planning (ERP) products, such as Epicor, offer event-
triggered reporting. However, this high-end feature also can be found in an entry-level 
product, Peachtree Complete. Its alarms automatically monitor amounts related to account 
balances, customers, vendors and employees.  
 
For accounting software packages that don't provide event-triggered alarms, a third-party 
solution often is available. For example, the CleverPath Portal (formerly known as Forest & 
Trees) from Computer Associates can extract data from a host of accounting software 
packages, spreadsheets and other databases. In addition, the software can send you a text 
message if it spots a potential problem. Likewise, the Cisco Agent can perform similar actions. 
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10.  Accuracy 
 
Of course this should go without saying, but financial 
statements and reports should be accurate. It seems 
ridiculous to mention this to a bunch of CPAs, however too 
often I encounter companies whose financial statements 
and reports are not accurate, and the readers of those 
statements know it. As a result, the financial statements 
and reports are not properly used to manage the business. 
To help ensure accuracy, follow these steps: 
 
Monthly Entries - Make sure that someone is assigned to 
enter the necessary journal entries each month. Make sure that they are entered 
correctly. Write up notes and explanations directing the bookkeeper as to the correct 
process. For example, explain the monthly loan payment amount must be debited against 
the interest expense and outstanding loan accounts each month in differing amounts 
according to the amortization schedule. 
 
Review – Make sure that someone knowledgeable is assigned to review the financial 
statements and reports each month for errors. Create a list of key steps to take such as 
preparing a bank reconciliation, performing a physical inventory count, spot checking key 
balances, comparing actual amounts to budgeted amounts and investigate any significant 
discrepancies.  
 
Errors – As errors are identified, take time to determine what caused the error and train 
that person responsible so that the error does not recur. 
 

11.  Reporting Frequency 
 
Financial statements and reports should be issued on a regular basis – daily, weekly, 
monthly, quarterly and annually. It has been my experience that often the bookkeeper 
will sit on information believing that it is their job to protect the privacy of all information. 
This is incorrect. Just the opposite is true, it should be the bookkeeper’s job to produce 
and deliver financial statements and reports on a continual and recurring basis. Both 
QuickBooks and Peachtree provide a tool that allows the bookkeeper you to print a batch 
of reports with a single click. As the CPA, you should make sure that these batches are set 
up properly.  
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12.  Electronic Reporting 

 
If possible, it is best to deliver electronic financial statements and reports via encrypted 
e-mail rather than to produce paper based reports for the following reasons: 
 
a. Paper reports take time to print. 
b. Paper reports must be delivered, faxed, or mailed.  
c. Paper reports use paper. 
d. Paper reports use toner. 
e. Paper reports result in wear and tear on your printer.  
f. Paper reports require you to go get paper, store paper, and load paper. 
g. Paper reports require you to go get toner, store toner, and load toner. 
h. Paper reports must be filed away in a drawer or filing cabinet. 
i. Securing paper reports in binders takes time. 
j. Report binders cost money. 
k. Storing report binders full of reports takes up storage space.  
l. Paper reports must later be moved to an archive room. 
m. Ultimately paper reports must be shredded. 
n. Paper reports cannot be copy and pasted into other applications such as Word. 
o. Paper reports make what-if analysis impossible without reentering the data. 
p. Paper reports make it impossible to generate a chart without re-entering the data. 
q. Paper reports are harder and more expensive to secure than electronic reports. 
r. Paper reports are more difficult to share with others. 
s. Paper reports are far more difficult to back up. 
t. Paper reports are impossible access remotely. 
u. Paper reports do not allow the user to drill into details by double clicking a number. 
v. Paper reports do not provide search tools to make it easy to locate an account. 
w. Electronic reports can be accumulated conveniently in a single folder for easy access. 
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13.  Automated Delivery 
 
If possible, it is best to have the accounting system automatically generate and deliver 
electronic financial statements and reports via encrypted e-mail at regularly scheduled 
intervals. The benefits are as follows: 
 
a. This eliminates the need for a bookkeeper to spend countless hours generating and 

delivering reports.  
b. This enables readers of those reports to learn to expect and rely on various financial 

reports at regularly scheduled intervals, rather than wonder when if ever the reports 
are forth coming. 

 
Some accounting systems provide the ability to schedule financial statements and reports 
to be delivered automatically at regularly scheduled intervals. For example, you could 
schedule the Detailed Aged Receivables report to be delivered each Tuesday and Friday 
at 10:00 am to the president, CFO, AR Clerk, and Sales Manager. As examples, both 
Microsoft Management Reporter and Crystal Reports (with the Navarre Report Scheduler 
Add-on) provide the ability to schedule the delivery of each and every report.  

 
14.  Timely Delivery 

 
Financial statements must be delivered timely. By the 10th day of the following month, 
before information grows stale. Many companies receive accurate financial statements 
once a year, well after the end of the year – too late to be used in the decision making 
process.   
 
Financial reports should be delivered daily, weekly or month depending upon the 
company and various factors. For example, I would recommend that inventory re-order 
reports be delivered twice a week or even once a day in an effort to best manage 
inventory. 
 
The trademark of a well-run company is a continuous effort to produce and deliver deep 
rich financial statements and reports on a continuing basis.   

 
15.  Customizing The Financial Statements and Reports 

 
Virtually every accounting system on the planet provides tools which allow you to 
customize your financial statements and reports to your specific needs. Financial 
statements and reports should be customized to include all of the pertinent information. 
Recipients should be asked to help review the financial statements and reports for missing 
info. 
 
In particular, statistical information such as units of sales can be added to enhance the 
reports. Many accounting systems allow the users to create new data fields which can 
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also flow to the financial statements and reports for enhanced reporting. In QuickBooks, 
these added data fields can be used to filter reports as well.  
 
The key point is that the seasoned CPA should do more than simply rely on the canned 
reports to meet the needs of the company. They should fully utilize the tools to ensure 
that the reporting is the best it can be. 

 
16.  Training Users to Read and Understand Financial Statements 

 
It is not enough to merely produce and deliver the financial statements and reports. The 
recipients of those financial statements and reports should know how to read and 
understand them. This is a delicate matter, for you don’t want to insult the recipient by 
questioning their ability to read the report. Nonetheless, you should sit down with 
recipients and point out key numbers and indicators to look for when examine each 
report.  

 
17.  Other 

 
In addition, there are several small tips that you should keep in mind when producing 
financial reports as follows: 
 
a. Well labeled report titles should appear on each page. 
b. Each page should be numbered using the “Page # of ##” format. 
c. The Calibri and Aerial fonts make numbers easier to read. 
d. Financial reports containing numerous zeros should suppress those zeros. 
e. In Excel, use the “Accounting Format” with the “Single” and “Double” Accounting 

underlines to achieve the look and feel that CPAs prefer. 
f. In Excel use the new “Spark Line” feature to help depict trends. 
g. In Excel use the “outlining” exploding and condensing. 
h. In Excel use “Superscripting” partially in your cell to referencing footnotes. 
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18. The Data Menu - Perhaps the parts of Excel that are of most value to CPAs, but least used by 
CPAs are the Data commands found under the Data menu in Excel 2003 and earlier, and on the 
data Ribbon in Excel 2007. These commands are shown below, and we will concentrate the next 
hour to studying these commands. 

 

 
 

 
 

19. Data Sorting - The Sort tool does exactly what it implies – it sorts and data. Key sorting points are 
as follows: 

 
1. Contiguous Data - The “A to Z” sorting tool can sort large matrix of data automatically 

as long as the data is contiguous. In other words, your data should contain no blank 
columns, no blank rows, and the columns must all be labeled. Only then will Excel 
always correctly select the entire matrix for sorting. 
 

2. A to Z Button - Simply place the cursor in the desired column for sorted, and press the 
A to Z or Z to A button as the case may be. Excel will automatically sort all continuous 
columns that have headings and all contiguous rows from the top row under the 
heading labels down to the last row in the selected column that contains data. (Note - 
If you accidently select 2 cells instead of just one, your results will not be correct.) 

 
3. Sort by 64 Columns - The “Sort” tool is dramatically enhanced in Excel 2007 as it now 

provides the ability to sort by up to 64 columns, instead of just 3 columns. Presented 
below is a dialog box which shows this expanded functionality.  
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4. Sort Left to Right – Excel has always provided the ability to sort left to right. To do so, 
select the options box in the Sort Dialog box and click the check box labeled “Sort left 
to Right” as shown below. 
 

 
 

5. Sort by Color – Excel 2007 now provides the ability to sort by font color or by cell color, 
or both. This is handy in many ways. Sometimes CPAs use color to tag or mark certain 
cells  - and later find it useful to be able to sort by those markings. In other situations 
CPAs use conditional formatting to apply color to cells using a wide variety of rules. 
Thereafter Excel can sort the data based on the resulting colors. The sort-by-color 
options are shown below. 
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To be accurate, it was possible to sort by color in Excel 2003. To accomplish this task, 
you needed to use the =CELL function in order to identify information about a given 
cell such as the cell color or font color. Thereafter, the results of that function could be 
used to sort rows – which effectively means that you can sort by color in Excel 2003 – 
but it takes a bit more effort. 
 

6. Sort By Custom List – Another sorting capability in Excel is the ability to sort by Custom 
List. For example, assume a CPA firm has ten partners, and the Managing partner 
prefers to be shown at the top of the list, and the remaining Partners based on 
seniority. In this case, you could create a Custom List in the excel Options dialog box 
listing the partners in the desired order, and then sort future reports based on that 
order. 
 
Perhaps a better example use of this feature would be to create a non-alphabetic 
custom list of your chart of accounts, and then sort transactions to produce a general 
ledger in chart of account order – even if your preferred chart of accounts is not 
alphabetical. the partner seniority does not match the alphabetic names, nor any  

 
20. Filtering Data - Using AutoFilter to filter data allows you to view a subset of your data in a range 

of cells or table. Once you have filtered the data, you can apply additional filters to further refine 
your data view. When you are done, you can clear a filter to once again redisplay all of the data. 
To use this tool, start with any list of data and turn on the AutoFilter tool. Then position your 
cursor in the column you want to filter and use the drop down arrows to apply your filters as 
shown in the screen below. 

 

 
 

Once the filters are applied, you will see a subset your data. For example, the screen presented 
below shows filtered data for only Macon and Savannah properties.  
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As filters are applied, a small funnel appears in the drop down arrow button to indicate that a 
filter has been applied. You can apply filters for multiple columns simultaneously. 
 
Key Points Concerning The AutoFilter Command: 
 

a. Contiguous Data – The AutoFilter tools works best when you are working with data that is 
contiguous. In other words, your data should contain no blank columns, no blank rows, 
and the columns must all be labeled.  
 

b. Filter by Multiple Columns -  You can filter by more than one column. 
 

c. Removing Filters – In Excel 2003 and earlier, a faster way to remove multiple filters is to 
turn off filtering and then turn filtering back on. In Excel 2007 you can simple click the Clear 
button in the Sort and Filter Group as shown below.  
 

a.  
 

d. Filters are Additive  - Each additional filter is based on the current filter and further 
reduces the subset of data. 
 

e. Three Types of Filters – You can filter based on list values, by formats, or by criteria. Each 
of these filter types is mutually exclusive for each range of cells or column table. For 
example, you can filter by cell color or by a list of numbers, but not by both; you can filter 
by icon or by a custom filter, but not by both.  
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a.  
f. Filters Enabled - A drop-down arrow  means that filtering is enabled but not applied. 

 

g. Filter Applied - A Filter button  means that a filter is applied. 
 

h. Filter Spanning - The commands under 
the All Dates in the Period menu, such 
as January or Quarter 2, filter by the 
period no matter what the year. This 
can be useful, for example, to compare 
sales by a period across several years. 
 

i. This Year vs. Year-to-Date Filtering - 
This Year and Year-to-Date are different 
in the way that future dates are 
handled. This Year can return dates in 
the future for the current year, whereas 
Year to Date only returns dates up to 
and including the current date. 
 

j. Filtering Dates - All date filters are 
based on the Gregorian calendar as  
decreed by Pope Gregory XIII, after 
whom the calendar was named, on 24 
February 1582. The Gregorian calendar 
modifies the Julian calendar's regular four-year cycle of leap years as follows: Every year 
that is exactly divisible by four is a leap year, except for years that are exactly divisible by 
100; the centurial years that are exactly divisible by 400 are still leap years. For example, 
the year 1900 is not a leap year; the year 2000 is a leap year. 

 
k. Filtering By Days of Week - If you want to filter by days of the week, simply format the 

cells to show the day of the week. 
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l. Top & Bottom Filtering - On the Data tab, in 

the Sort & Filter group, click Filter. Point to 
Number Filters and then select Top 10. To 
filter by number, click Items. To filter by 
percentage, click Percent. Note - Top and 
bottom values are based on the original 
range of cells or table column and not the 
filtered subset of data. 
 

m. Above & Below Average Filtering - On the 
Data tab, in the Sort & Filter group, click 
Filter. Point to Filter by Numbers that are 
Above/Below Average. Note – These values 
are based on the original range of cells or 
table column and not the filtered subset of data. 
 

n. Filtering Out Blanks - To filter for blanks, in the AutoFilter menu at the top of the list of 
values, clear (Select All), and then at the bottom of the list of values, select (Blanks). 
 

o. Filtering By Color - Select Filter by Color, and then depending on the type of format, select 
Filter by Cell Color, Filter by Font Color, or Filter by Cell Icon. 
 

p. Filter by Selection - To filter by text, number, or date or time, click Filter by Selected Cell's 
Value and then: To filter by cell color, click Filter by Selected Cell's Color. To filter by font 
color, click Filter by Selected Cell's Font Color. To filter by icon, click Filter by Selected Cell's 
Icon. 
 

q. Refreshing Filters - To reapply a filter after the data changes, click a cell in the range or 
table, and then on the Data tab, in the Sort & Filter group, click Reapply. 
 

21. Data Subtotals – Excel provides an automatic subtotaling, which will automatically calculate 
and insert subtotals and grand totals in your list or table. Once inserted, Excel recalculates 
subtotal and grand total values automatically as you enter and edit the detail data. The 
Subtotal command also outlines the list so that you can display and hide the detail rows for 
each subtotal. Examples of a the Subtotal dialog box and a resulting subtotaled table are 
shown below. 
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Key points to Consider When Using Subtotaling are as follows: 
 

a. Contiguous Data – The Subtotal tools works best when you are working with data that is 
contiguous. In other words, your data should contain no blank columns, no blank rows, 
and the columns must all be labeled.  
 

b. Sort Before Your Subtotal - You must sort the data by the column you wish to Subtotal 
by, else you will receive erroneous 
results.  
 

c. Other Mathematical Applications - The 
Subtotal tool not only calculates 
subtotals, but it can also calculate 
minimums, maximums, averages, 
standard deviations, and other 
functions.  
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d. Subtotals in 2007 Tables – Excel 2007 deploys Subtotaling a little differently in that the 

Subtotal tool appears at the bottom of each column in each table, as shown in the screen 
below. 
 

 
 

e. Automatic Outlining - Subtotaling automatically inserts Outlines, which is really cool. You 
can then condense and expand the data in total and by subtotal. Some CPAs also like to 
copy and paste the condensed subtotal information to another location but find that this 
process copies and pastes all of the data. There are two ways to achieve a clean copy and 
paste without grabbing all the hidden data as follows: 
 

i. CTRL key – Hold the Control Key down while you individually click on each subtotal 
row. This will enable you to copy and paste just the subtotal data. This approach 
can be problematic because if you mis-click, you have to start over. 

 
ii. Select Visible Cells – A better approach is to use the Select Visible Cells tool. This 

tool will select on the data you can see, after which the copy and paste routine 
will  yield the desired results. This option is better because it is faster and less error 
prone.  

 
22. PivotTables   

 
The PivotTable report tool provides an interactive way to summarize large amounts of 
data. Use should use the PivotTable tools to crunch and analyze numerical data PivotTable 
reports are particularly useful in the following situations: 

 
a. Rearranging rows to columns or columns to rows (or "pivoting") to see different 

summaries of the source data.  
b. Filtering, sorting, grouping, and conditionally formatting your data. 
c. Preparing concise, attractive, and annotated online or printed reports  
d. Querying large amounts of data. 
e. Subtotaling and aggregating numeric data. 
f. Summarizing data by categories and subcategories 
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g. Creating custom calculations and formulas. 
h. Expanding and collapsing levels of data. 
i. Drilling down to details from the summary data  

 
In essence, PivotTables present multidimensional data views to the user – this process is 
often referred to as “modeling”, “data-cube analysis”, or “OLAP data cubes”.  To re-
arrange the PivotTable data, just drag and drop column and row headings to move data 
around.  PivotTables are a great data analysis tool for management.   
 
If you have never used a PivotTable before, initially the concept can be difficult to grasp. 
The best way to understand a PivotTable is to create a blank Pivot Table and then drag 
and drop field names onto that blank table. This way you will see the resulting pivot table 
magically appear and it will help you better understand the important relationship 
between the pivot pallet and the field name list. 
 
Let’s create a simple PivotTable. Start with an Excel worksheet data that contains several 
columns of data – the data must include column and row headings and it helps if the data 
is contiguous. Place your cursor anywhere in the data and select PivotTable from the Data 
menu in Excel 2003 and click Finish; or from the insert Ribbon in Excel 2007.  This process 
is shown below: Let’s start with a page of data summarizing the results of tax season as all 
of the time sheet entries have been entered onto a single worksheet as shown below.  

 

 
 

Place your cursor anywhere in the data and select PivotTable from the Insert Ribbon as 
shown below: 
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For learning purposes let’s right mouse click on the pivot table and select PivotTable 
Options, Display, Classic PivotTable Layout. Your screen will now appear as follows: 
 

 
 

I like for CPAs to learn how to use Pivot Tables in this view because it visually helps them 
understand the all important relationship better the blank pivot palette and the PivotTable 
field List, both elements of which are shown in the screen above. 
 
To proceed, simply drag and drop field names shown on the right onto the blank Pivot 
palette shown on the left. With each drop, your report grows larger. As an alternative you 
could use the check boxes next to field names – this functionality is new in Excel 2007. 
After added some data to your blank Pivot Palette, your data will look something like this: 
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Next format and filter the Pivot Report. Very quickly your report comes together as shown 
below. Notice the filter button has been applied and a Pivot table style has also been 
applied for appearance.  
 

 
 
Double clicking on any number in a pivot report will automatically produce a new 
worksheet complete with all supporting detail that comprises the summary number.  
 
There are a multitude of PivotTable options that can be applied to alter the appearance or 
behavior of your Pivot table.  
 
Key Points Concerning Pivot Tables are as Follows: 

 
a. You can create as many Pivot Reports as you want from your initial raw data page. Your 

raw data remains unchanged as new Pivot tables are created. 
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b. As your raw data changes, your pivot tables are updated each time you press the refresh 

button. Or if you prefer you can set your PivotTables to update themselves at regularly 
scheduled intervals – say every ten minutes. 
 

c. A key to understanding PivotTables is understanding the relationship between the Blank 
Pivot palette and the PivotTable Field list. As data is selected in the list, it appears on the 
Pivot table Report.  
 

d. You can alter the PivotTable simple by dragging and dropping the field names in different 
locations on the Pivot palette, or in different locations in the PivotTable Field list Box. 
 

e.  PivotTables can be pivoted. 
 

f. PivotTables can be sorted by any Column. (Or by any row when sorting left to right) 
 

g. PivotTables can be Filtered. 
 

h. PivotTables can be Drilled. 
 

i. PivotTables can be copied and pasted. 
 

j. PivotTables can be formatted using PivotTable Styles, as shown below. 
 

 
 

k. Subtotals and grand totals can be displayed or suppressed at the users desire. 
 

l. PivotTable Data can be shown as numbers or percentages at the users desire. 
 

m. PivotTable can not only be summed, it can be averaged, minimized, maximized, counted, 
etc. 
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n. Blank rows can be displayed or suppressed at the users desire. 
 

o. A new feature called “Compact Form” organized multiple column labels into a neatly 
organized outline which is easier to read. 
 

p. PivotTables can query data directly from any ODBC compliant database. The PivotTable 
tool for accomplishing this task is not included in the ribbon – you will find it by Customizing 
the Quick Access Tool Bar and searching the “Commands Not Shown in the Ribbon” tab to 
find the PivotTable and PivotChart Wizard Option. 
 

q. Many accounting systems can push data out of the accounting system into an Excel 
PivotTable format – this is commonly referred to as an OLAP Data Cube. OLAP data Cube 
is just a fancy word for PivotTable – and there is no difference.  
 

r. PivotTables can automatically combine data from multiple data sources. The PivotTable 
tool for accomplishing this task is not included in the ribbon – you will find it by Customizing 
the Quick Access Tool Bar and searching the “Commands Not Shown in the Ribbon” tab to 
find the PivotTable and PivotChart Wizard Option. 
 

 
 

s. Excel also provides a PivotChart function which works similarly to PivotTables. Presented 
below is an example PivotChart.  
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Excel 2003 PivotTables work very similarly as shown below. Excel creates a blank 
PivotTable, and the user must drag and drop the various fields from the PivotTable Field 
List onto the appropriate column, row, or data section. As you drag and drop these items, 
the resulting report is displayed on the fly. Here is the blank Pivot Palette view. 
 

 
 
Now drag and drop field names from the Pivot Table field list onto the Pivot pallet. This 
action will automatically create Pivot Table reports – and they will change each time you 
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drop additional field names, or move field names around. Presented below are but a few 
examples of hundreds of possible reports that could be viewed with this data through the 
PivotTable format. 
 

 
 
This report shown above shows the total resulting sales for each marketing campaign for 
each of the 4 months marketing campaigns were conducted. 
 

 
 
In this screen we see the same information is shown as a percentage of the total. A few 
observations include the fact that overall Radio Spots are the most profitable type of 
campaign, but only in April and July. In January and October, local ads and direct mail, 
respectively, produce better results. Further, April campaigns had the best response 
overall. 
 

 
 
Further analysis in the screen above tells us that our results vary widely from one city to 
the next. In New York, coupons were least effective, but coupons were most effective in 
Columbus. Pivot charts based on PivotTable data can be modified by pivoting and/or 
narrowing the data.  They can also be published on the Internet (or on an Intranet) as 
interactive Web pages.  This allows users to “play” with the data. The chart below provides 
a visual look at the data shown above. 
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23. Filtering Pivot Tables - If you take a close look at your resulting pivot tables, you will notice 

that Excel automatically inserts a filter button on each field list as shown by the drop down 
arrows in the screen below:  

 

 
 

This drop down filter list makes it easy to refine your report to include just the data you 
want. 

 
24. Drilling Pivot Tables - Another nice feature in pivot tables is that they are automatically 

drillable. Simply double click on any number in a pivot report top have Excel automatically 
insert a new sheet and produce the detailed report underlying the number you clicked on. An 
example of this is shown below: 
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25. Pivot Table Options - By right mouse clicking on your pivot table you will reveal several option 

settings boxes as shown below. For example, these options boxes control the types of 
subtotals produced in your pivot reports. Excel also offers a pivot table options box as well as 
a layout wizard that makes producing pivot tables a little easier.  
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26. Database Queries  
 

Microsoft Excel can also query and retrieve data you want from an external data source. For 
example, you can retrieve Microsoft Excel data about a specific product by region. You can 
create a simple query by using the Query Wizard, or you can create a more complex query by 
using the advanced features of Microsoft Query. 
 
To use Microsoft Query to retrieve external data, you must: 
 

1. Have access to an external data source - If the data is not on your local computer, 
you may need to see the administrator of the external database for a password, user 
permission, or other information about how to connect to the database. 
 

2. Install Microsoft Query - If Microsoft Query is not available, you might need to install 
it. 
 

3. Specify a source to retrieve data from, and then start using Microsoft Query -   For 
example, if you want to insert database information, display the Database toolbar, 
click Insert Database, click Get Data, and then click MS Query.  

 
For example, suppose we have some data in our accounting system – Sage MAS 200 ERP that 
we would like to analyze in Excel.  We can use the Database Query Wizard to build a query 
that will extract the data we need and place it in an Excel spreadsheet. 
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The first step is to select the type of database you want to query and to select the specific 
database. 
 

 
 
Upon the selection of the desired database a list of tables will be presented. Choose the 
desired tables, and select the desired data fields to be imported. You will then have the option 
to filter and sort the data before it is imported.  Finally you will be given the option to save 
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the query so that you can run it at a later date without having to start from scratch. Excel will 
then return a table full of the data you requested as shown in the screen below. 
 

 
 
 
27. XPS versus PDF - XPS (XML Paper Specification) is a new format developed by Microsoft that 

offers an alternative to Adobe System’s PDF (Personal Document Format) format. A key 
advantage of both XPS and PDF formats is that the fonts used in the document are embedded 
in the file so that the document will display and print properly on other computers and 
printers. For Word 2007 and 2010 users, an advantage of the XPS format is that no additional 
software is required to view the XPS based documents because Microsoft Word automatically 
views documents with the XPS format. However, PDF documents require the user to 
download a PDF reader, such as the Acrobat Reader in order to view the document.  To create 
an XPS document in Word 2007 or 2010, from the Office Start button or File tab, select Save 
As, and select the XPS Document option form the Save as type: drop down box shown below, 
provide a file name in the File name: box, and click OK.   
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Be aware that once you have saved a Word document as a PDF or XPS file, it cannot be easily 
edited or converted back to a Microsoft Office file format without specialized software or a 
third-party add-in. Both PDF and XPS file formats are frequently used to produce finalized 
documents to be shared. For example, financial reports, tax returns, legal documents, 
contracts, newsletters, and resumes are examples of documents that are commonly 
converted to PDF or XPS formats prior to sharing.   

 
28. XML in Excel - Microsoft Office Excel makes it easy to import Extensible Markup Language 

(XML) (Extensible Markup Language (XML): A condensed form of Standard Generalized 
Markup Language (SGML) that enables developers to create customized tags that offer 
flexibility in organizing and presenting information.) data that is created from other databases 
and applications, to map XML elements from an XML schema (XML Schema: A formal 
specification, written in XML, that defines the structure of an XML document, including 
element names and rich data types, which elements can appear in combination, and which 
attributes are available for each element.) to worksheet cells, and to export revised XML data 
for interaction with other databases and applications. Think of these XML features as turning 
Office Excel into an XML data file generator with a familiar user interface. 

 
1. Why use XML in Excel?  

a. XML data and schema files  
b. Key XML and Excel scenarios  

2. The basic process of using XML data in Excel  
a. Working with XML maps  
b. Using the XML Source task pane  
c. Element types and their icons  
d. Working with single-mapped cells  
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e. Working with repeating cells in XML tables  
f. XML map security considerations  
g. Importing XML data  
h. Working with an inferred schema  
i. Exporting XML data  

3. Using the Excel macro-enabled Office XML Format file  

 
Why use XML in Excel? 
XML is a technology that is designed for managing and sharing structured data in a human-
readable text file. XML follows industry-standard guidelines and can be processed by a variety of 
databases and applications. Using XML, application designers can create their own customized 
tags, data structures, and schemas. In short, XML greatly eases the definition, transmission, 
validation, and interpretation of data between databases, applications, and organizations. 
 
XML data and schema files 
Excel works primarily with two types of XML files: XML data files (.xml), which contain the custom tags 
and structured data. Schema files (.xsd), which contain schema tags that enforce rules, such as data type 

and validation.  Note   The XML standard also defines Extensible Stylesheet Language Transformation 

(XSLT) (XSL Transformation (XSLT): A file that is used to transform XML documents into other types of 
documents, such as HTML or XML. It is designed for use as part of XSL.) (.xslt) files, which are used to apply 
styles and transform XML data into different presentation formats. You can apply these transforms before 
you import XML files into Excel and after you export XML files from Excel. If XSLT files are linked to XML 
data files that you import into Excel, you do have the option to apply or not apply the formatting before 
the data is added to the worksheet, but only when you open an XML file by using the Open command on 
the Microsoft Office Button . 
 

Key XML and Excel scenarios 
By using XML and Excel, you can manage workbooks and data in ways that were previously impossible or 
very difficult. By using XML maps, you can easily add, identify, and extract specific pieces of business data 
from Excel documents. For example, an invoice that contains the name and address of a customer or a 
report that contains last quarter's financial results are no longer just static reports. You can easily import 
this information from databases and applications, revise it, and export it to the same or other databases 
and applications. The following are key scenarios that the XML features are designed to address: 
 

1. Extend the functionality of existing Excel templates by mapping XML elements onto existing cells. 
This makes it easier to get XML data into and out of your templates without having to redesign 
them.  

2. Use XML data as input to your existing calculation models by mapping XML elements onto existing 
worksheets.  

3. Import XML data files into a new workbook.  

4. Import XML data from a Web service into your Excel worksheet.  

5. Export data in mapped cells to XML data files independent from other data in the workbook.  
 

The Basic Process of using XML data in Excel 
The following diagram shows how the different files and operations work together when you use XML 
with Excel. Essentially, there are five phases to the process: 
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1. Adding an XML schema file (.xsd) to a workbook  

2. Mapping XML schema elements to individual cells or XML tables  

3. Importing an XML data file (.xml) and binding the XML elements to mapped cells  

4. Entering data, moving mapped cells, and leveraging Excel functionality, while preserving XML 
structure and definitions  

5. Exporting revised data from mapped cells to an XML data file  
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Budget Case Study 
 
The Situation – You are the new CFO for a $30 million organization called “PaperCut” that sells, 
implements, and supports paperless systems. The company has 3 locations – Atlanta, Boston and 
San Francisco. You are the CFO in charge of the Atlanta Budget, as well as the overall budget. The 
Boston and San Francisco operations are headed up by Controllers David and Lynn, respectively. 
Each location has 4 Departments – Sales, Implementation, Support and Administration. 
Previously the company has not used an official and does not have a budget budgeting system. 
Your task is to implement a formal budgeting system, and to work with David and Lynn to prepare 
the budget for 2008. 
 
The Big Picture - Your Goals Are:  
 

1. Start by creating a budget template for use by the various department heads in Excel. 
 
2. Make the template available to David and Lynn, as well as other company officials by 

publishing the budget template to the Internet using a Sharepoint site, or an ordinary web 
site.   

 
3. Request David and Lynn to complete the budgets for their respective locations. 

 
4. Consolidate the budget worksheets into one overall budget. 

 
5. Produce a variety of pivot reports that can be used to study the budget. 

 
6. Apply finishing touches such as rounding, charts, and summary pages. 

 
7. Produce a second worksheet summarizing the budget worksheets into a single worksheet 

of Raw Data. 
 

8. Create PivotTable Reports and Pivot Charts.  
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This Case Study Covers the following Excel Features and Concepts: 
 

1. Labeling Worksheets 
2. Simple & Distribution Formulas 
3. Subtotal Formulas 
4. The Double Underline Format 
5. Data Input Identification 
6. Copying Worksheets 
7. Double Clicking the Fill Handle to 

Copy 
8. Dragging the Fill Handle to Copy 
9. Suppressing Dollar Signs 
10. Document Inspector 
11. Un-protecting Cells 
12. Password protecting an Excel File 
13. Duplicating Templates 
14. Sharing Excel Files Across the Internet 
15. Accessing Excel Files Via the Internet 
16. Using Linear Regression Analysis   
17. Totaling Multiple Worksheets 
18. File Linking, Creating Linking Formulas 
19. Copying Linking Formulas 
20. Linking Strategies 
21. Inserting Worksheets 
22. Selecting Entire Worksheets 
23. Copying Worksheets Between Files 
24. Grouping Worksheets 
25. Editing Grouped Worksheets 
26. Absolute References 

 

27. Naming Worksheet Tabs 
28. The Round Function 
29. Freezing Panes 
30. Charting 
31. 3-D Pie Charts 
32. Pie Chart Borders, Effects & Fill 
33. Dragging Pie Slices 
34. Working with Tables 
35. Working with Drop Down Filters 
36. Error Checking 
37. Pivot Tables 
38. The PivotTable Palette & Field List 
39. Pivoting Strategies 
40. Pivot Table Styles 
41. Drilling PivotTables 
42. Filtering PivotTables 
43. Using Text Formulas  
44. Expanding Table Ranges 
45. Debugging PivotTable Results 
46. Labeling Worksheet tabs 
47. Duplicate Copies of Worksheets 
48. Moving Columns in PivotTables 
49. Refreshing Data Links 
50. PivotCharts 
51. Filtering PivotCharts 
52. Inserting Picture Fills in PivotCharts 

 

 
 
 
 
 
 
 
 
 
 
Start with a clean worksheet and create a budget grid like the one shown below.  
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Comments about this grid follow: 
 

- The top of this worksheet is properly labeled with company name, report title, 
date, and time stamp. 

 
- The account numbers and the chart of accounts are included in columns A & B. A 

few additional rows have been inserted to accommodate new accounts, if any. 
 
- Columns for location and department are included in columns C & D. 

 
- A column for the total is provided in column E 

 
- The next 12 columns contain formulas that divide the total amount by 12, and 

distribute the budget across twelve months. 
 

- Subtotals are provided at the bottom of the total and monthly columns. Use the 
Accounting Double Underline Format to provide underlines which do not touch. 

 
- A yellow background and grid border have been included everywhere that data is 

intended to be entered into the worksheet. This helps prevent others from 
inadvertently overwriting formulas amounts elsewhere in the worksheet. 

 
1. Once the initial budget grid has been created on Sheet1, copy this worksheet (including 

formatting and column widths) to four additional worksheets. Do this as follows: 
 

a. Select the entirety of Sheet1; 
b. Press “Ctrl+C” to copy;  
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c. Select Sheets 2, 3, 4, and 5 (use the Ctrl + mouse click to select the sheet tabs);  
d. Press “Ctrl+V” to Paste.  
e. Edit the “Department” columns to read “Sales”, “Service”, “Support”, & “Admin”. 
f. Label the sheet tabs according to their department. 

 
 

The results should appear as follows: 
 

 
 
2. On the “Total” sheet (formerly Sheet1), type a formula in the top left hand corner of the 

input grid (E7 in this case) to sum the amounts in E7 on the following 4 worksheets. The 
formula should appear as follows: 

 

 
 

3. Copy this formula down and across to fill in the entire grid, as suggested by the arrows in 
the screen below. 
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Since these cells on the Total worksheet now contain formulas, remove the yellow 
background so that other users do not confuse this worksheet as a data input worksheet. 
Also, change the department column to read “All Departments”. 

  
4. Format the cells to suppress dollar signs, except for the top and bottom rows of the data 

input grid. This step is intended to help eliminate unnecessary screen clutter. Make this 
change to all five worksheets at the same time by selecting all five worksheet tabs.  

 
5. Run the “Document Inspector” and add the appropriate information in the “File 

Properties” from the Excel Menu’s Prepare option (discussed in depth in the Expense 
Report Case Study).  

 
6. Unprotect the cells with a yellow background, and turn on worksheet protection. 

(discussed in depth in the Expense Report Case Study). 
 

7. Save the file three times as “PaperCut Budget 2008 – Atlanta”, “PaperCut Budget 2008 – 
SFO”, and “PaperCut Budget 2008 – Boston”. As you save these files, apply a password to 
each file using the Excel Menu’s File, Save As, Tools, General Options menu options. The 
following dialog box will appear requesting that you supply a password.  

 

 
 

8. Next, edit the San Francisco and Boston files so that they reflect the proper location on 
all five worksheets in the location column. Once again, make this change to all five 
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worksheets at the same time by selecting all five tabs, typing in the new location name in 
the top cell of the location column, and then copy down. When completed, re-save these 
files. You should end up with three files, one each for Atlanta, San Francisco, and Boston. 
These files might appear as follows in a window on your computer. 

 

 
 

9. Next save these file to your Internet Web Site or Sharepoint web site. If you have never 
saved a file to your Internet web site before, it is virtually the same procedure as you are 
already used to, except you browse to your web site instead of your computer or file 
server. Further, you will need to supply the necessary web site password in order to 
complete the save process. For example, when I perform this procedure I simply open the 
SFO Excel file and select “Save As” from the Excel menu, and provide the following 
address:  

 
“HTTP://www.CarltonCollins.com/PaperCut Budget 2008 - SFO” 
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You will be prompted to provide your user name and password, and then this procedure 
will save your file to the Internet. Repeat this process for the Boston file.  

 
10. Send an e-mail to David and Lynn containing links to these two files. Call them to let them 

know the passwords to both the Excel files, and the web site so that they can open and 
use the Excel files directly from the web server (You should call because you would not 
want to send passwords through e-mail unless your e-mail is also encrypted.  
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11. Clicking on the resulting link will launch the following dialog box enabling David and Lynn 
to either save the file to their computer, or launch it from it’s current location on the web 
site. 

 

 
 
12. The next step is for you, David, and Lynn to input the budget data into the respective 

budget templates. There are a variety of approaches to accomplishing this next step, and 
an interesting approach is to use linear regression analysis applied against the actual 
revenue and expense data for the past four or five years.  

 
As an example of this, the screen below shows how a CPA has highlighted the actual 
revenue and expenses for 2002 through 2006, and then used AutoFill’s Regression 
Analysis to predict 2007 values. Whenever Excel is presented with the task of filling values 
based on three or more values, it defaults to using Linear Regression Analysis to predict 
the next values. 

 

 
 
As a quick refresher, consider how Regression works in the following chart. 
 

Drag here to 
generate 2007 

values 
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13. The regression example above suggests one possible strategy for predicting budget 
values. 

 
In this case study the budget workbook we designed is designed to accommodate a more 
straightforward approach in which the budget line item amounts are entered into the 
total column (for each of the four department worksheets), and formulas then spread the 
amounts evenly across twelve months.  
 
However, the user is not restricted to this approach only. As alternatives, the user may 
wish to instead enter monthly amounts in the “month” columns, and a formula to total 
these monthly amounts in the “total” column. Or, the user may wish to input the total 
budget for the location in the “Total” Sheet, and use formulas to distribute those amounts 
across the various departments and months. One of the primary reasons Excel is so 
popular for creating budgets is this flexibility to create budgets, reports and workbooks 
using practically any approach desired.  
 
The budget template also includes a summary sheet (named “Totals”) so that the 
personnel using this template can not only see the individual departmental budgets, but 
the overall budget for all departments as well.  

 
14. Once the budget information has been entered for Atlanta, San Francisco and Boston, it 

is time to consolidate the budget into a single Excel file. There are many ways to 
accomplish this task and many users would simply copy and paste the resulting data into 
a single file. The problem with this “Copy and Paste” approach is that if the original budget 
files are edited for any reason, then the consolidated Excel file is not automatically 
updated.  Therefore for purposes of this case study, we will link the consolidating budget 
excel File to the three underlying budgets for Atlanta, San Francisco and Boston. In this 
manner, if you, David or Lynn decide to make any changes to your budgets, those changes 
will automatically flow through to the consolidated budget and final budget reports. The 

2003 Actual 

2004 Actual 

2005 Actual 

2006 Actual 

2008 Predicted 

2007 Predicted 

The black dots represent actual revenues for 2003 – 2006. Regression 
attempts to find a straight line in which the square of the distances between 
these actual amounts and the line add up to the “least” amount. Thereafter, 
the line’s continuation provides the path to the next predicted values, 
represented by white dots.  
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graphic below shows the relationship of the four Excel files that will ultimately comprise 
the 2008 budget.  

 
 
 

 
Consolidation Approach #1 

 
15. There are many approaches to creating links between worksheets, and most preparers 

take the approach that formulas summarizing data should be linked from one sheet to 
another. I prefer a more detailed approach in which all data is completely replicated 
through links from all supporting files to one consolidating file, and then summarized. I 
prefer this approach because it is straight forward and it results in a better audit trail for 
tracing data from the reports back to their origin. 
 

16. To start, begin with a blank worksheet, and insert new worksheets until you have a total 
of 13 blank worksheets. Save the file to a name called “Budget Consolidation”. Naming 
the file now will make it easier to navigate the files back and forth as links are built in the 
new worksheet. 
 

17. Next, copy one of the worksheets in the completed Atlanta budget file and paste it to the 
13 new worksheets in the new consolidated budget file. To copy, click in the upper left 
hand corner of the worksheet to select the entire worksheet. To paste, toggle to the new 
consolidating worksheet, select all 13 worksheets as a group, and then paste. This will 
place a copy of the budget template on all 13 worksheets. 
 

18. With all 13 worksheets still selected, erase the data in the columns labeled “Location”, 
“Department”, “Total”, and the various “Months”. Turn off the gridlines. Your 
consolidating worksheet should appear as follows: 
 

SFO Budget 

BOS Budget 

ATL Budget 

Consolidated 
Budget 

Links 
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19. Next, select Sheet2 in the consolidating budget file, and place your cursor in cell C7, or 

the first data cell under the Location column. Enter an equals sign (“=”), and then toggle 
to the completed Atlanta Budget file and point to cell C7 on the “Sales” Sheet, and press 
Enter. This action will create the first link in your consolidating budget file as shown 
below. 
  

 
 

20. Edit the formula in cell C7 to remove the absolute references. Use the F4 key in edit mode 
to toggle the absolute references off. 
 

21. Copy this formula down by double clicking the fill handle. This action will automatically 
copy cell C7 down thru cell C42, because the cells in the adjacent column B all contain 
values. Your worksheet should appear as follows: 
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22. With the cells C7 through C42 still highlighted, now drag the fill handle over to the 
December column. This will copy the linking formulas in the Location column across the 
page, creating a mirror image of the Atlanta sales data as shown below. 
 

 
 

23. Repeat this process for the remaining eleven 11 worksheets (3 through 13), linking the 
consolidating budget file to all three of the budget files for Atlanta, Boston and San 
Francisco. 
 

24. Touch up the consolidating budget file by labeling the Worksheet Tabs and formatting the 
worksheets by using the Format Painter to apply the formatting from worksheet 1 to the 
12 budget worksheets. 
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25. On worksheet 1, label the worksheet tab “Consolidated” and create a formula to combine 

the amounts on Sheets 2 through 13, as shown below. 
 

 
 

26. Copy this formula down and across to fill the data area. Label the “Location” and 
“Department” Columns as “All” Locations” and “All Departments”. 
 

 
 

27. Next, insert a new worksheet, label the tab “Rounded Budget” and copy the consolidated 
worksheet to this new blank worksheet. Insert a formula in cell C7 using the Round 
function as shown below: 
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28. Copy this formula down and across to create a consolidated budget with rounded 

numbers. Hide Columns C & D (Location and Department). Freeze the panes with your 
cursor in cell E7. Your final budget is now ready for distribution and review.  
 

 
 

29. To provide a visual representation of the budget expenses, highlight the expenses in the 
total budget column, and include the expense descriptions. Insert a 3-D pie chart from 
the Insert menu. Drag the resulting pie chart to a clean part of the worksheet and resize 
as needed. You results should appear as follows: 
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30. Edit the Pie Chart by inserting solid line borders and increase the width of the borders. 
Change the fill effect, and drag one of the pie slice away from the pie slightly. Select the 
pie slice and insert a picture to “Fill” the slice. Your results might appear as follows: 
 

  
  

Consolidation Approach #2 
 

http://www.carltoncollins.com/


www.CarltonCollins.com  

Copyright October 2013 – J. Carlton Collins, CPA  Page 129 

31. As an alternative approach, we will now consolidate the original completed budgets for 
the three locations into a single budget worksheet. This approach will make it easy to use 
Pivot Tables, Subtotals and Data Filters to consolidate, analyze and report the data. Start 
with a blank worksheet, and copy the column headings from any of the completed 
budgets to the new blank worksheet as a starting point as shown below. 
 

 
 

32. Starting in the first data cell (A7) in column 1 (Account #), type an equals sign ((“=”) and 
toggle to the completed Atlanta Budget file and point to cell A7 on the “Sales” Sheet, and 
press Enter. This action will create the first link in your consolidating budget file as shown 
below. 
 

 
 

33. Edit the formula in cell A7 to remove the absolute references. Use the F4 key in edit mode 
to toggle the absolute references off. 
 

34. Copy this formula down by dragging the fill handle down to cell A42. Your worksheet 
should appear as follows: 
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35. Repeat this process of creating links to the remaining 11 worksheets of budget data as 
shown in the screen below. 
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36. Now that the data is consolidated into a single worksheet, you can now use the various 
data tools to analyze the resulting budget data. To start with, filter the data by placing 
your cursor in any cell in the data area, and select Table from the insert menu. This action 
will automatically convert your data to a table and apply filter drop downs to each column 
as shown below. 
 

 
 

37. Highlight the columns after Column A and apply a comma formatting with no decimal 
places.  
 

 
 

38. Notice that Excel will tag each formula with a green triangle I the upper left hand corner 
indicating that you have inconsistent formulas in your range. This is a good feature as 
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Excel helps identify potential errors, but in this case the inconsistent formulas are 
intended. In this situation, you have two options. You can either turn off error checking 
for inconsistent formulas (Under Excel Options, Formulas, Error Checking Rules), or you 
can select each cell and instruct Excel to ignore these errors (By selecting Error Checking 
from the Formulas Ribbon as shown below).  
 

 
 

39. Use the filter to display only the Insurance expense items as shown below. 
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40. Remove the filter to display all data, and place your cursor in the Description column. Sort 
the data from high to low. With your cursor in the Table range, select “Summarize with 
PivotTable” from the “Design” Ribbon’s “Tools” chunk.   
 

 
 

41. This action will create a new worksheet with a blank Pivot Palette as shown below.  
 

 
 

42. In the PivotTable Field List Box (to the right), check the Description and Total Check Boxes.  
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43. Expand the Pivot Table to also include “Locations”. Drag the “Locations” drag box from 
the Row Labels to the Column Labels area of the PivotTable Field List as shown below. 

 

 
 
44. Expand the Pivot Table further to also include “Departments”. Drag the “Departments” 

drag box from the “Row Labels” to the “Column Labels” area of the “PivotTable Field List” 
as shown below. Highlight the PivotTable area and change the numeric formatting to 
comma, no decimal places. Choose a PivotTable Style from the Design Ribbon. The results 
might appear as follows: 

 

http://www.carltoncollins.com/


www.CarltonCollins.com  

Copyright October 2013 – J. Carlton Collins, CPA  Page 135 

 
 

45. Uncheck the “Departments” checkbox in the PivotTable Field List, and double click on any 
amount in the PivotTable, such as Insurance for San Francisco in the amount of $298,879. 
This action will automatically drill into the summary data, creating a new worksheet 
summarizing all of the supporting data as shown below. 
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46. Next, return to the “Raw Data” page and produce a second PivotTable that includes both 
Locations and Departments. Assign a Pivot Style and comma formatting. The results are 
shown below. 
 

 
 
Notice that the data contains the line item titled Revenue. To fix this problem, some users 
will try to resort the Pivot Table. Others will attempt to add in the accounts. Both of these 
solutions are incorrect. The proper avenue is to return to the “Raw Data” worksheet and 
add a column which uses Text Formulas to combine the account and description together.  
 

 
 

With this new column added, select “Convert to Range” from the “Design” Ribbon’s 
“Tools” chunk, and then select “Table” from the “Insert” Ribbon’s “Tables” chunk. This 
action will reestablish the table range to include the newly inserted column of data. 
(Caution this action also breaks the link to other PivotTables if they were created using 
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the “Summarize with PivotTable” command, but not if they were created with the “Insert 
PivotTable” command. Now, create a new PivotTable by selecting Summarize with 
PivotTable from the Design Ribbon’s Tools chunk, and use the newly created column “Acct 
& Desc” to produce the next PivotTable as shown below: 
 

 
 
Notice that Revenue now appears at the top of each “Location” budget report section, as 
it should. Too often CPAs bog themselves down in PivotTables attempting to debug their 
results by manipulating the PivotTable settings and sorting when the true solution is 
found by adding columns and formulas to the raw data on the “Raw Data” page.  

 
47. Tidy the Excel file by eliminating unnecessary worksheets and labeling each worksheet 

tab using a reasonable name, such as those shown below. 
 

 
 

48. Make a copy of the “Budget by Department” worksheet by right mouse clicking on the 
worksheet tab and selecting Move of Copy, and checking the “Create A Copy” checkbox. 
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49. Rename this worksheet “Budget by Months”. Deselect the “Departments” field. Add the 
“individual month” fields to this PivotTable report. Remove the “Totals” field, and then 
add back the “Totals” field (this action will move the totals to the end of the report). Your 
results might appear as follows: 
 

 
 

50. As a grand finale, go back to one of the competed budgets, say for Boston, and change 
one of the budget amounts. Watch as the change instantly flow to and appear in both of 
your consolidated budget files, including all subsequent Tables, Reports, Charts, and 
PivotTables. Now if you, David or Lynn make even a single change in any of the budget 
templates, the results are updated everywhere without any further action on your part, 
aside from recalculating your data sources using the “Refresh” command. Go ahead, give 
it a try! 
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51. Complete the budget process by producing a PivotChart from the “Raw Data” worksheet 
by selecting “Insert Column Chart” from the “Insert” Ribbon’s “Chart” chunk. Resize the 
Chart and apply a “Chart Style”. 
 

 
   
Notice that the revenue line item severely skews the chart’s appearance. To correct this problem, 
use the drop down filter to deselect the revenue line item to produce the following Chart. Format 
the plot area with a suitable image.  
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What’s New in Microsoft Office 2013? 
 
This course covers 8 hours of the very best and most essential Excel 2013 functionality that CPAs 
should be using in the performance of their jobs. This course is best suited for moderate level 
Excel users who know how to use the basic functionality of Excel, but have seldom explored the 
more powerful features and capabilities that Excel has to offer, including the following new 
features found in Excel 2013.  
 
1. Quick Analysis - helps you analyze data more quickly by offering data layouts. 
2. Flash Fill - watches you work and applies logic to help you complete your tasks.  
3. PowerView - enables you to create new report types, such as the interactive map charts. 
4. Timeline Slicer - helps you slice and dice Pivot data containing dates. 
5. Create Relationships tool – enables you to build PivotTables from multiple data sources.  
6. Drill Up and Cross Drill - Drill upward and cross drill to related tables. 
7. Improved Edit Mode - edit mode, Excel no longer displays an apostrophe. 
8. Excel Instances - Excel now opens each workbook in a separate instance.  
9. New PivotTable Tools - decouple PivotCharts so they stand alone. 
10. Fifty New Functions – Bring the total number of functions to 450. (1) 
11. Recommended Pivot Tables & Charts – To help you work quicker and easier. 
12. New Chart Controls - Excel pops up new chart controls.  
13. Get A Link – Send Excel workbooks links instead of workbooks via email. 
14. Publish Excel Data to Social Media – Embed Workbooks directly in Facebook. 
15. Review Tools - new inquire Add-in reviews design, function and data dependencies. 
16. Excel Compare tool - similar to Word’s Compare tool. 
17. Touch-Screen Enabled – Makes excel accessible on touch-screen mobile devices. 
18. Windows 8 Style Tiles – For easy launching and navigation. 
19. Cloud-Enabled – Save Excel workbooks directly to your free cloud data storage SkyDrive. 
20. Office 2013 Web Apps – a free version of Excel 2013 is available via the cloud. 
21. Subscription Pricing – enables you to install Excel on five devices, and run Excel from the cloud. 

 
These concepts are described in greater depth below. 
 

 
 

Many CPAs worry that Office’s new touch-screen functionality means the product’s new 
ribbons that will be time-consuming to learn, but this is not the case. Office 2013’s ribbons work 
and look almost exactly like Office 2010’s ribbons, and transitioning to the new product involves 
only a minor learning curve. While the new touch-screen controls provide new ways to launch 
and use the applications on touch-screen devices, the 2010-style ribbon along with a standard 
keyboard and mouse remains to be the primary means for operating the product. On mobile 
devices, the ribbons offer the same menu options, but they are redesigned to better fit smaller 
hand-held devices. Most of Office’s new touch controls work similar to mouse-clicks, but new 
gestures have been added. For example, you can navigate Excel workbooks or multiple pages in 
Word by swiping your finger across the screen. You can also pinch and spread to shrink or enlarge 

New Global Features in Office 2013 
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your spreadsheets, documents or presentations. A new Touch Mode button inserts more space 
around the Ribbon’s icons so operating the touch controls on smaller devices is a little easier.  

 
 Office’s new square, color-coded tiles (see figure) are used to launch applications on your 
tablet, smartphone, or computers equipped with touch-screen monitors. The tiles can be resized 
and rearranged to your preference, and the color-coded schemes make it easier to identify and 
select the correct application. Office’s tiles match the Windows 8 tiles which have been praised 
by some for their simplicity and utility. 

 

  
Examples of Office 2013 Quick Launch Tiles in Windows 8 

 
Office binds you to the cloud in many ways. For example, Office automatically connects 

to your free cloud-based SkyDrive which includes 20 GBs of data storage space, email account, 
contact management, calendar management, and the following free web apps: 2013 editions of 
Word, Excel, PowerPoint, and OneNote. These web apps are cloud-based versions of the popular 
applications (with limited commands and features), accessible from any web browser on a 
desktop, laptop, tablet or smartphone device.  
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Office 2013's Free Web Apps 

 

Since everyone has access to these free web apps, troublesome file-sharing barriers and 
file compatibility issues are removed; therefore, CPAs can use Office 2013 with the confidence of 
knowing that documents and workbooks they produce can be easily viewed and edited by others. 
(These web apps are available for free by signing up for a SkyDrive account as described in the 
October, 2011 JofA article titled A Sky-High Solution - page 78).   

 

Microsoft offers Office via a subscription plan and many CPAs are finding the rental plan 
to be a better option than purchasing the product. Pricing options and functionality for selected 
Office 2013 editions are summarized in the table below. 

 
 

Office Edition 
 

Users/PCs Price Included 

 
Purchase Options: 

Office Home & Business 1 user/3 PCs $279.99 Word, Excel, PowerPoint, OneNote, 
Outlook 

Office Professional 1 user/2 PCs $499.99 Word, Excel, PowerPoint, OneNote, 
Outlook, Access, Publisher 

 
Subscription Options: 

Office 365 Professional Plus 1 user/5 PCs $15/Month Word, Excel, PowerPoint, OneNote, 
Outlook, Access, Publisher 

Office 365 E3 Plan 1 user/5 PCs $20/Month Word, Excel, PowerPoint, OneNote, 
Outlook, Access, Publisher, Cloud-
based email, Web conferencing, 

Shared calendars, Cloud-based team 
sites, Office Web Apps 

Pricing Options for Selected Editions of Office 2013 

 

Seven advantages for renting rather than purchasing are as follows: 
 
1. Installs on more PCs - The subscription plan allows you to install Office professional on five 

computers or devices, compared to just two or three installations with the purchased product.  

http://www.carltoncollins.com/


www.CarltonCollins.com  

Copyright October 2013 – J. Carlton Collins, CPA  Page 143 

  
2. Never upgrade again – Renters will never face an upgrade decision again as future product 

enhancements are included automatically.  
 
3. Superior iMap email - The subscription plan includes a cloud-based email solution using iMap 

(Internet Message Access Protocol), which is stronger than the traditional Pop3 (Post Office 
Protocol) email solution. This is because iMap maintains email messages, replies, contacts, 
tasks and calendars in a central location so you can access them from any of your computers, 
the web, or mobile devices. In contrast, Pop3 maintains this information on the individual 
computers, thus accessing this information from multiple computers or devices is more 
problematic. 

 
4. Better security - In the cloud, data is securely encrypted from your computer to the cloud, 

and your data remains encrypted in the cloud. Your data is also backed up automatically on a 
continuous basis and is protected by world-class firewalls, anti-virus software, and intrusion 
monitoring solutions. A significant amount of technology, cost and effort is needed to 
duplicate this level of security on a local computer or file server. 

 
 
5. File Sharing – The subscription plan includes a cloud-based SkyDrive (starting at 20 GBs), team 

management tools, and file syncing options to help groups work in collaboration. You can 
grant permission to others to access your SkyDrive files or folders, even if they don’t use 
Office. In the cloud environment, email attachments are unnecessary because you can send 
recipients a link instead of attachments; as a result, emails travel faster, deliveries are no 
longer hung up due to attached file size restrictions, and attachments no longer contribute to 
oversized inbox data files.  
 

6. Eliminate upfront capital costs – For larger companies, the subscription plan eliminates their 
need to borrow money to purchase product. By opting for the “pay as go” subscription plan, 
companies can expense the costs as a monthly operating expense;  

 
7. Eliminate balance sheet liabilities – For larger companies, FASB 47 requires disclosure of long 

term obligations, but because Office’s subscription plan requires no long-term commitment, 
these rental obligations need not be included on the balance sheet. 

 
 

 
 

Of all the Office 2013 applications, Excel is the beneficiary of the most impressive 
enhancements. Excel’s new Flash Fill watches you work and applies logic to help you complete 
your tasks. The example pictured below (see figure below) contains a list of 44 first and last names 
in Column A, which I want to separate into Columns B and C. As I start typing the first name of 
the second record in Column B; Excel’s Flash Fill guesses what I’m trying to do and offers to fill in 
the remaining 42 first names (as shown in grey text). 

  

New Features in Excel 2013 
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Excel's New Flash Fill Tool 

 

Excel’s new PowerView inserts new worksheets connected to your data, and then 
enables you to create new report types, such as the interactive map chart presented in figure 4. 
The resulting PowerView Map report is zoomable, and filters can be applied to display partial 
data. 

 

 
PowerView Tool Depicting a New Zoomable Map View 
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PowerView worksheets can be published as standalone, interactive reports to Microsoft 
SharePoint’s PowerPivot Gallery or other reporting service destinations. Some of the tools 
provided by PowerView include the ability to create a dashboard containing multiple 
PowerViews, apply themes and backgrounds, insert pictures and text boxes, insert collapsible 
and expandable tiles, and add data slicers. CPAs who work with PivotTables will likely appreciate 
Excel’s new Timeline Slicer which helps users slice and dice Pivot data that contain dates. As an 
example, selecting the dates May through October on the Timeline slicer (pictured) adjusts the 
PivotTable to display May thru October data.  

 

 
Excel's New Timeline Slicer provides a  

Visual Method of Filtering a PivotTable by Date 

 

As an advanced enhancement, Excel provides the new Create Relationships tool for 
building table relationships in workbooks that contain at least two tables sharing at least one 
common field name.  

  

 
Excel's New Relationship Tool for Pivoting Multiple Sources of Data 

 

Once relationships are established, the More Tables option can be used to display 
additional tables allowing you to add data fields from mutiple tables to PivotTables, as pictured. 
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Connecting Multiple Sources of Data to a PivotTable 

 

Another PivotTable enhancement involves drillability. Previously, users could only drill 
down on PivotTable data, but now you can also Drill Up and Cross Drill to related tables.  

 
Excel offers new tools which can analyze your data and recommend a variety of 

PivotTable and Chart layouts to best illustrate the data. This new functionality is especially useful 
to novice users who are less familiar with Excel’s functionality, but can also help avid Excel users 
save time too. Simply place the cursor anywhere in your data area and select Recommended 
PivotTables (or Recommended Charts) and in return, Excel offers various PivotTable and Chart 
options and as pictured in the figure. 
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Excel's New Recommend PivotTables and Recommend Charts Tools 

 
Excel’s Quick Analysis tool also helps you analyze data by offering a variety of formatting, 

charts, totals, tables and sparkline layouts to instantly summarize large volumes of data (see 
figure). When using Quick Analysis to scrutinize text-only data, text specific options for 
highlighting duplicate or unique text items appear. 
 

 
Example of Excel's New Quick Analysis Tool 

 

Microsoft has added 50 new functions to Excel (increasing the total number of functions 
to 450), and the following 12 new functions in particular will appeal to many CPAs. 

 
1. ARABIC – Converts roman numerals to regular numbers, for example V, IX, and XX are converted 

to 5, 9, and 20. 
 

2. CEILING.MATH – This function can be used to round a number up to a specific interval, such as 
the nearest 99 cents, as demonstrated in figure 10. 
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Example Use of Excel's New Ceiling.Math Function 

 
3. DAYS – Calculates the number of days between two dates. 

 
4. FLOOR.MATH - Rounds numbers down to a specific interval, and also can be used to round 

negative numbers towards zero, instead of towards a smaller number. For example, -8.5 can be 
rounded to -8.0 (instead of the -9.0 results delivered by the older Round function).  

 
5. FORMULATEXT – Displays referenced formulas as text, and can be used to improve formula 

reading, reviewing and printing. 

 
6. ISFORMULA – Returns the value TRUE if the referenced cell contains a formula. 

 
7. ISOWEEKNUM – Calculates the week during the year in which a given date falls. As an example, I 

used this formula to determine that I was born in the 53rd week of 1959. 

 
8. PDURATION - Returns the number of periods required by an investment to reach a specified 

value. For example, you could calculate that $1,000 invested at 6% APR would take 26.89 years to 
reach a value of $5,000. (This function approach is faster than constructing a 322 row table to 
figure this out.) 

 
9. RRI – This function returns an equivalent interest rate for the growth of an investment. For 

example, you could calculate that a $1,200 mutual investment that grew to $5,600 in 18 years 
earned an average return of 8.93%. 

 
10. SHEET – Calculates the sheet number of the referenced sheet. For example, you might use this 

function to determine that your interest rate assumptions are entered on the 46th sheet in your 
workbook. 

 
11. SHEETS – Calculates the total number of sheets in a referenced range.  

 
12. SKEW.P – Like the Skew function, SKEW.P calculates the standard deviation of a string of data, 

but bases its calculation on the entire population instead of a sample of the population. This 
function could be used to determine whether each line item of a company’s historical financial 
statement data is consistent enough to use as a basis for projecting the following year’s budget.  

 
For a complete listing of the 50 new functions in Excel 2013, visit 

www.carltoncollins.com/newfun.htm or scan the tag. 
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